# Contents

- **Preface** ................................................................. 9
  - Documentation Conventions ........................................ 10
  - Related Publications ................................................ 11
  - Customer Support .................................................... 11
  - Information You Should Have ...................................... 11
  - User Feedback ........................................................ 12
  - Information Builders Consulting and Training .................. 12

1. **Introducing WebFOCUS Visual Discovery** .......................... 15
   - WebFOCUS Visual Discovery Key Features ....................... 15
   - WebFOCUS Visual Discovery Components ....................... 16

2. **Installing WebFOCUS Visual Discovery Components** ............. 19
   - Installing WebFOCUS Visual Discovery Development Components ........................................ 19
   - VZ Web Server (Thick Client) Deployment ......................... 19
   - WebFOCUS Visual Discovery VZ Web Server (Thick Client) ..................................................... 20
     - Installing WebFOCUS Visual Discovery VZ Web Server ..................................................... 21
     - Reference: Development Requirements for VZ Web Server .................................................. 21
     - Procedure: How to Install WebFOCUS Visual Discovery VZ Web Server ............................. 21
     - Procedure: How to Confirm the Vz.cab File Version Number ............................................. 22
   - Using a WebFOCUS Visual Discovery Page for the First Time ............................................... 22

3. **Developing an Analytic Dashboard** .................................. 23
   - Creating Visual Discovery Output Files ............................. 23
     - Reference: Format Conversions for FORMAT VISDIS .......... 23
     - Procedure: How to Create a Visual Discovery Output File From Report Painter .................... 24
     - Syntax: How to Create a Visual Discovery Output File Using WebFOCUS Language ................ 25
   - Developing an Analytic Dashboard From Developer Studio .................................................. 26
     - Procedure: How to Create a WebFOCUS Visual Discovery Analytic Dashboard .................... 27
   - Naming Controls ........................................................ 28
   - Selecting Data .......................................................... 28
     - Procedure: How to Add and Select Data .......................... 28
     - Reference: Properties and Settings Dialog Box ............... 29
     - Reference: Data Tab .................................................. 29
     - Reference: Data Tab Icons ......................................... 30
   - Assigning Color to the Data and the Graph .......................... 31

Using WebFOCUS Visual Discovery to Develop Analytic Dashboards 3
<table>
<thead>
<tr>
<th>Procedure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procedure: How to Change Graph Element Colors.</td>
<td>32</td>
</tr>
<tr>
<td>Reference: Colors Tab.</td>
<td>33</td>
</tr>
<tr>
<td>Coloring a Graph by a Field.</td>
<td>36</td>
</tr>
<tr>
<td>Procedure: How to Color a Graph by a Selected Field.</td>
<td>36</td>
</tr>
<tr>
<td>Values are VisDis Color By.</td>
<td>37</td>
</tr>
<tr>
<td>Procedure: How to Color a Visual Discovery Control Using Values are VisDis Color By.</td>
<td>37</td>
</tr>
<tr>
<td>Choosing Selection Options.</td>
<td>40</td>
</tr>
<tr>
<td>Reference: Selecting Tab.</td>
<td>41</td>
</tr>
<tr>
<td>Specifying Fonts and Titles.</td>
<td>43</td>
</tr>
<tr>
<td>Reference: Fonts Tab.</td>
<td>43</td>
</tr>
<tr>
<td>Reference: Titles Tab.</td>
<td>44</td>
</tr>
<tr>
<td>Using Goal Lines.</td>
<td>44</td>
</tr>
<tr>
<td>Procedure: How to Add Goal Lines.</td>
<td>44</td>
</tr>
<tr>
<td>Procedure: How to Move Goal Lines.</td>
<td>45</td>
</tr>
<tr>
<td>Procedure: How to Hide Goal Lines.</td>
<td>45</td>
</tr>
<tr>
<td>Procedure: How to Remove Goal Lines.</td>
<td>45</td>
</tr>
<tr>
<td>Procedure: How to Select Values Above/Below the Goal Line.</td>
<td>45</td>
</tr>
<tr>
<td>Animating Data.</td>
<td>45</td>
</tr>
<tr>
<td>Procedure: How to Animate a Bar, Line, or Pie Chart.</td>
<td>46</td>
</tr>
<tr>
<td>Selecting Primary and Secondary Order.</td>
<td>46</td>
</tr>
<tr>
<td>Procedure: How to Select Primary and Secondary Order.</td>
<td>46</td>
</tr>
<tr>
<td>Displaying Labels.</td>
<td>47</td>
</tr>
<tr>
<td>Procedure: How to Select Label Mode.</td>
<td>47</td>
</tr>
<tr>
<td>Procedure: How to Show or Hide Individual Labels Using the Pop-up Menu.</td>
<td>48</td>
</tr>
<tr>
<td>Preselecting Values.</td>
<td>48</td>
</tr>
<tr>
<td>Procedure: How to Preselect Values.</td>
<td>48</td>
</tr>
<tr>
<td>Passing Between a Report and a Visual Discovery Control.</td>
<td>49</td>
</tr>
<tr>
<td>Procedure: How to Pass a Parameter From a Visual Discovery Control to a Report.</td>
<td>49</td>
</tr>
<tr>
<td>Procedure: How to Pass a Parameter From a Report to a Visual Discovery Control.</td>
<td>51</td>
</tr>
<tr>
<td>Chaining Into a Visual Discovery Control.</td>
<td>54</td>
</tr>
<tr>
<td>Procedure: How to Chain Into a Visual Discovery Control.</td>
<td>54</td>
</tr>
<tr>
<td>Excluding and Restoring Data.</td>
<td>57</td>
</tr>
</tbody>
</table>
### Procedure: How to Exclude and Restore Data

- Working With Visual Discovery Controls on the Web
- Selecting Data
- Restoring Excluded Data
- Changing the Display
- Saving a Control as an Image
- Saving the State of Analysis
- Reference: BookMarks Tab
- Accessing Visual Discovery Online Help

### 4. Tutorial: Building a Visual Discovery Analytic Dashboard with Advanced Chart Controls

- Before You Begin
- Building an Analytic Dashboard With Visual Discovery Components
- Procedure: How to Create the HTML File
- Procedure: How to Create the Bar Charts
- Procedure: How to Create the Data Constellation
- Procedure: How to Create the Pie Chart
- Procedure: How to Create the Summary Sheet
- Building an Application With Advanced Chart Controls
- Procedure: How to Create a Visual Discovery Control Panel Menu Bar
- Procedure: How to Create a Drop Down List Control for Selector Shapes
- Procedure: How to Create a Drop Down List Control to Color By Fields
- Procedure: How to Create a Push Button Control That Hides Excluded Items
- Procedure: How to Create a Push Button Control That Toggles Actively Selected Items
- Procedure: How to Create a Push Button Control to Refresh Components
- Procedure: How to Create Radio and Push Button Controls to Collect Data and Pass to a Report

### 5. Deploying Visual Discovery Applications

- Deploying WebFOCUS Visual Discovery Applications for VZ Web Server (Thick Client)
- Procedure: How to Configure Visual Discovery Pages for Thick Client Deployment in Managed Reporting
- Procedure: How to Configure Visual Discovery Pages for Thick-Client Deployment in the WebFOCUS Client
Procedure: How to Use the Scenario Wizard to Deploy Visual Discovery Application Files (Thick-Client) .................................................. 110

6. Visualization Components: Descriptions and Usage ............................... 113

   What Is a Glyph? ................................................................. 114

   Bar Charts ........................................................................ 114

      Procedure: How to Change the Orientation of a Bar Chart. ............. 115

      Using a Spine Plot in a Bar Chart ......................................... 116

      Procedure: How to Change the Style of a Bar Chart to a Spine Plot. 116

      Reference: Spine Plots in Bar Charts .................................... 116

   Using Clusters in a Bar Chart .................................................. 117

      Procedure: How to Create a Cluster Bar Chart. ......................... 117

      Reference: Bar Chart Tab .................................................. 118

      Reference: Bar Chart Pop-up Menu .................................... 119

   Line Charts ........................................................................ 122

      Procedure: How to Change the Orientation of a Line Chart ........... 123

      Reference: Line Chart Tab ................................................ 123

      Reference: Line Chart Pop-up Menu ................................... 124

   Pie Charts .......................................................................... 127

      Rotating Data .................................................................... 128

      Procedure: How to Rotate Data .......................................... 128

      Exploding Data .................................................................. 128

      Procedure: How to Explode Data ....................................... 128

      Aggregating Data in Pie and Bar Charts .................................. 128

      Procedure: How to Toggle Net Aggregation Modes in a Pie Chart. 129

      Procedure: How to Toggle Net Aggregation Modes in a Bar Chart. 129

      Reference: Pie Chart Tab .................................................. 130

      Reference: Pie Chart Pop-up Menu .................................... 131

   Histograms .......................................................................... 133

      Procedure: How to Change the Orientation of a Histogram. .......... 133

      Procedure: How to Select the Histogram Scale ......................... 134

      Smoothing a Histogram .................................................... 134

      Procedure: How to Smooth a Histogram ................................ 134

      Reference: Histogram Tab ................................................ 135

      Reference: Histogram Pop-up Menu ................................... 135
Counts ................................................................. 137
  Reference: Formats for Counts ................................. 138
  Reference: Counts Tab. ........................................... 139
  Reference: Counts Pop-up Menu. .............................. 139
Data Constellations .............................................. 141
  Weighting a Graph. ............................................... 143
    Procedure: How to Weight a Graph. ......................... 143
Data Constellation Maps ....................................... 143
  Procedure: How to Set Up Nodes and Links. ................ 145
  Procedure: How to Set the Placement Properties of an Image.. 146
  Reference: Data Constellations Tab. .......................... 148
  Reference: Nodes/Links Tab. .................................. 150
  Reference: Placement Tab. ..................................... 151
  Reference: Data Constellation and Data Constellation Map Pop-up Menu. 152
Data Sheets ..................................................... 154
  Reference: Data Sheet Tab. ..................................... 156
    Reference: Data Sheet Pop-up Menu ......................... 157
Multiscapes .................................................... 159
  Procedure: How to Reorder a Multiscape. .................... 161
  Procedure: How to Change the Display Method and Select the Field to Weight By .... 161
  Procedure: How to Color a Multiscape By Size. .............. 162
  Reference: Multiscape Tab. .................................... 163
  Reference: Multiscape Pop-up Menu. .......................... 164
  Creating a 3D Multiscape. .................................... 166
    Procedure: How to Create a 3D Multiscape. ................. 166
    Reference: 3D Tab. ............................................ 167
Paraboxes ....................................................... 168
  Reference: What Is a Boxplot? ................................. 169
  Procedure: How to Set Parabox Presentation Options. ........ 171
  Reference: Ordering Data in a Parabox. ....................... 171
  Reference: Parabox Tab. ....................................... 172
  Reference: Parabox Pop-up Menu. ............................. 174
Scatter Plots .................................................. 175
  Inserting a Trend Line in a Scatter Plot. ...................... 176
    Procedure: How to Use a Trend Line. ....................... 177
A. Using the Visual Discovery JavaScript API .......................................................... 195
   About JavaScript API .................................................................................. 195
   Customizing Visual Discovery Applications With JavaScript .................. 196
   Using the VzScript Library ........................................................................ 199

B. Glossary ................................................................................................. 201

Customer Connections ............................................................................. 211
Preface

This documentation describes how to use WebFOCUS Visual Discovery to develop analytic dashboards. It is intended for developers.

**Note:** The WebFOCUS toolset generates the rich FOCUS fourth generation language. While this language is very extensive, the WebFOCUS toolset only supports a subset of the language and only specific syntax constructs. While the user can manually modify the content of these WebFOCUS procedures/files, there is no guarantee that the user will be able to open the modified procedure in the tool.

How This Manual Is Organized

This manual includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter/Appendix</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introducing WebFOCUS Visual Discovery</td>
<td>Provides an overview of WebFOCUS Visual Discovery.</td>
</tr>
<tr>
<td>2 Installing WebFOCUS Visual Discovery Components</td>
<td>Describes how to install WebFOCUS Visual Discovery, and the VZ Web Server.</td>
</tr>
<tr>
<td>3 Developing an Analytic Dashboard</td>
<td>Describes how to develop an analytic dashboard. This topic covers tasks and options available for all the different graph components.</td>
</tr>
<tr>
<td>5 Deploying Visual Discovery Applications</td>
<td>Describes how to deploy WebFOCUS Visual Discovery applications using the VZ Web Server (thick client).</td>
</tr>
<tr>
<td>6 Visualization Components: Descriptions and Usage</td>
<td>Provides the business use for all of the visualization components and how to edit the component properties.</td>
</tr>
<tr>
<td>A Using the Visual Discovery JavaScript API</td>
<td>Provides the example code and information on basic JavaScript functions.</td>
</tr>
<tr>
<td>B Glossary</td>
<td>Describes key terms found in this manual.</td>
</tr>
</tbody>
</table>
# Documentation Conventions

The following table describes the documentation conventions that are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>THIS TYPEFACE</strong></td>
<td>Denotes syntax that you must enter exactly as shown.</td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td>Represents a placeholder (or variable), a cross-reference, or an important term.</td>
</tr>
<tr>
<td><strong>underscore</strong></td>
<td>Indicates a default setting.</td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td>Represents a placeholder (or variable), a cross-reference, or an important term. It may also indicate a button, menu item, or dialog box option that you can click or select.</td>
</tr>
<tr>
<td>Key + Key</td>
<td>Indicates keys that you must press simultaneously.</td>
</tr>
<tr>
<td>{}</td>
<td>Indicates two or three choices. Type one of them, not the braces.</td>
</tr>
<tr>
<td>[]</td>
<td>Indicates a group of optional parameters. None is required, but you may select one of them. Type only the parameter in the brackets, not the brackets.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>Indicates that you can enter a parameter multiple times. Type only the parameter, not the ellipsis (...).</td>
</tr>
<tr>
<td>.</td>
<td>Indicates that there are (or could be) intervening or additional commands.</td>
</tr>
<tr>
<td>.</td>
<td></td>
</tr>
<tr>
<td>.</td>
<td></td>
</tr>
</tbody>
</table>
Related Publications

Visit our Technical Content Library at http://documentation.informationbuilders.com. You can also contact the Publications Order Department at (800) 969-4636.

Customer Support

Do you have any questions about this product?

Join the Focal Point community. Focal Point is our online developer center and more than a message board. It is an interactive network of more than 3,000 developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques. Access Focal Point at http://forums.informationbuilders.com/eve/forums.

You can also access support services electronically, 24 hours a day, with InfoResponse Online. InfoResponse Online is accessible through our website, http://www.informationbuilders.com. It connects you to the tracking system and known-problem database at the Information Builders support center. Registered users can open, update, and view the status of cases in the tracking system and read descriptions of reported software issues. New users can register immediately for this service. The technical support section of www.informationbuilders.com also provides usage techniques, diagnostic tips, and answers to frequently asked questions.

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-6130. Customer Support Consultants are available Monday through Friday between 8:00 a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can also give you general guidance regarding product capabilities. Please be ready to provide your six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders representative about InfoResponse Online, or call (800) 969-INFO.

Information You Should Have

To help our consultants answer your questions effectively, be prepared to provide the following information when you call:

- Your six-digit site code (xxxx.xx).
- Your WebFOCUS configuration:
  - The front-end software you are using, including vendor and release.
  - The communications protocol (for example, TCP/IP or HLLAPI), including vendor and release.
  - The software release.
Your server version and release. You can find this information using the Version option in the Web Console.

The stored procedure (preferably with line numbers) or SQL statements being used in server access.

The Master File and Access File.

The exact nature of the problem:

- Are the results or the format incorrect? Are the text or calculations missing or misplaced?
- Provide the error message and return code, if applicable.
- Is this related to any other problem?

Has the procedure or query ever worked in its present form? Has it been changed recently? How often does the problem occur?

What release of the operating system are you using? Has it, your security system, communications protocol, or front-end software changed?

Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if you are having problems joining two data sources, have you tried executing a query containing just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff welcomes your opinions regarding this document. You can contact us through our website, http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of training courses for this and other Information Builders products.
For information on course descriptions, locations, and dates, or to register for classes, visit our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an Education Representative.
Introducing WebFOCUS Visual Discovery

WebFOCUS Visual Discovery is an integrated extension of WebFOCUS Enterprise Reporting that enables you to create advanced data visualization for executive-level dashboards. Data visualization turns raw data into perceptive images, providing a powerful and dynamic instrument for the discovery and reasoning of quantitative information. Advantages of data visualization include:

- Significantly increasing the interpretability and usability of complex business data by displaying it as geometric shapes (points, lines, circles, rectangles, and so on) with various attributes (proximity, size, color, and so on) that represent its value or meaning.
- Enabling identification of crucial trends and patterns.
- Improving discovery of data relationships impossible or difficult to see with tables and reports.
- Enabling executives and managers to easily view and understand Key Performance Indicators (KPIs).

In this chapter:

- WebFOCUS Visual Discovery Key Features
- WebFOCUS Visual Discovery Components

WebFOCUS Visual Discovery Key Features

WebFOCUS Visual Discovery provides advanced graphical techniques for creating visual perspectives of multi-dimensional business data to answer a broad range of questions. It also provides robust chart interactivity so you can visually analyze and detect trends and anomalies across multiple dimensions and categories. Its features make it a visual analog of Online Analytical Processing (OLAP) or multivariate analysis.

Features of WebFOCUS Visual Discovery include:

- Combination of multiple related charting controls on the same webpage for a multi-faceted view.
- Dynamic interactive charting (for example, line, bar, pie, histogram, and multiscape), allowing users to make selections directly from a chart.
Complex graph types (for example, data constellations, paraboxes, and time tables), allowing users to visually identify the cause-and-effect relationship between categories and measures.

Manipulation of the display of data by sorting, scrolling, and zooming.

Full control over attribute sizing and shaping, positioning, stacked colors, labeling, weighting, and animation to make the interpretation of data easier.

Simultaneous display of detailed data and aggregated data to allow users to jump from a summarized trend to the facts. Visual Discovery accommodates large volumes of data and enables users to find the detail in the volume.

Interactive switching between any displayed variable on a chart, such as categories, measures, and stacking variables.

Support for WebFOCUS drill-down reports.

**WebFOCUS Visual Discovery Components**

WebFOCUS Visual Discovery controls are graphical components that are available through Developer Studio, and are developed using the HTML Composer tool. In HTML Composer, you can author webpages that contain visual controls embedded in a dashboard layout. Those pages can then be made available for end users.

For more information on HTML Composer, see the *Designing a User Interface for a Web Application With HTML Composer* manual.

The following steps outline the procedure for creating a Visual Discovery dashboard for end users, as discussed throughout this manual:

1. Installing Developer Studio with a Visual Discovery license.
2. Developing a Visual Discovery dashboard.
3. Installing and configuring the Visual Discovery thick-client server for the WebFOCUS run-time environment.
4. Deploying the Visual Discovery application files to the WebFOCUS run-time environment.

**Installing Developer Studio with a Visual Discovery license.** If you license Visual Discovery, then its development components are installed with WebFOCUS Developer Studio. Use HTML Composer to develop your Visual Discovery application. You can run your application directly from HTML Composer in Developer Studio, and through a browser in your development environment.

If you are installing Developer Studio with Visual Discovery on a machine that has a previous version of Visual Discovery installed, you must uninstall the previous version.

To uninstall Visual Discovery:
1. Navigate to the Add or Remove Programs feature on your computer. For example, in Windows, you can access this feature in the Control Panel.

2. Select ADVIZOR Solution Components.

3. Click Remove and follow any additional prompts or instructions.

**Developing a Visual Discovery dashboard.** You can create Visual Discovery controls using HTML Composer in Developer Studio. These graphical components are ActiveX controls. You can customize each component from the HTML Composer tool in design time and from the browser at run time.

**Installing and configuring the Visual Discovery thick-client server for the WebFOCUS run-time environment.** Thick-client deployment methods are required to power Visual Discovery webpages after they have been developed.

The VZ Web Server provides a thick-client, web browser-based application that is deployed with embedded ActiveX controls to provide thick-client functionality to users.

For more information, see *Installing WebFOCUS Visual Discovery Development Components* on page 19.

While you develop with these ActiveX controls, they are powered by the physical installation of Visual Discovery with Developer Studio. Once deployed for the end user, ActiveX controls are powered by the Visual Discovery VZ Web Server (thick client). For more information on types of components, see *Visualization Components: Descriptions and Usage* on page 113.

**Deploying the Visual Discovery application files to the WebFOCUS run-time environment.** When you choose to deploy the Visual Discovery application files so that an end user may use the HTML pages at run time, you can use the deployment scenario wizard in the projects area, or manually copy and edit the files.

For more information, see *Deploying Visual Discovery Applications* on page 107.
Installing WebFOCUS Visual Discovery Components

This topic describes how to install the WebFOCUS Visual Discovery components, and WebFOCUS Visual Discovery VZ Web Server (thick client).

In this chapter:

- Installing WebFOCUS Visual Discovery Development Components
- VZ Web Server (Thick Client) Deployment
- WebFOCUS Visual Discovery VZ Web Server (Thick Client)

Installing WebFOCUS Visual Discovery Development Components

If you license Visual Discovery, then its development components are installed with Developer Studio. In addition to the Visual Discovery components, you need to install the WebFOCUS Visual Discovery VZ Web Server (thick client) for deployment purposes.

VZ Web Server (Thick Client) Deployment

Thick-client deployment methods are required to power Visual Discovery webpages after they have been developed. For more information on the process that converts a Visual Discovery webpage from a development state to a production state, see Deploying Visual Discovery Applications on page 107.

The VZ Web Server provides a thick-client, web browser-based application.

WebFOCUS Visual Discovery VZ Web Server (thick client). Thick Client deployment means that the Visual Discovery components run on the workstation of the end user as binary ActiveX controls within an Internet Explorer page. The ActiveX controls are installed on a workstation the first time an end user accesses a webpage that uses them. Webpages that use the visual components contain parameters and scripts to configure them and load data into them from network sources. The server directory from which the webpages are accessed also must contain an LPK file to license the ActiveX controls for use in the client browsers, and the Vz.cab installation file must be stored on the VZ Web Server.

The thick client works with Apache Tomcat™ as both a web server and an application server. IIS can be used as a web server, with Apache Tomcat or another application server supported by WebFOCUS when running with the WebFOCUS Servlet.
An important issue to consider when designing a thick-client Visual Discovery webpage is licensing and the ability of the end user to obtain the necessary files to render the Visual Discovery components. For information on copying the required files, see Deploying WebFOCUS Visual Discovery Applications for VZ Web Server (Thick Client) on page 107.

The following diagram shows the configuration and processing flow for a thick client.

**WebFOCUS Visual Discovery VZ Web Server (Thick Client)**

In a thick-client web deployment, the Visual Discovery components run on the workstation of the end user as binary ActiveX controls within an Internet Explorer page. The ActiveX controls are installed on a workstation the first time an end user accesses a webpage that uses them. The user then interacts with the results locally.
Important:

- For remote development in Managed Reporting, you must copy the visdis directory from Developer Studio to a corresponding directory on the WebFOCUS Client. Copy the visdis folder and all its contents from `\ibi\DevStudio81\ibi_html\visdis` (where Developer Studio is installed) to `\ibi\WebFOCUS81\ibi_html` (where the WebFOCUS Client is installed). Once you have done that, the WebFOCUS Client and Developer Studio will have a mirror image directory named visdis.

- Also, in Managed Reporting remote development, users other than the developer may access the Visual Discovery webpage. Therefore, you may need to configure the Visual Discovery webpage for thick-client deployment, as described in *How to Configure Visual Discovery Pages for Thick Client Deployment in Managed Reporting* on page 108.

### Installing WebFOCUS Visual Discovery VZ Web Server

This topic describes system requirements and installation steps for WebFOCUS Visual Discovery VZ Web Server. VZ Web is a thick-client web deployment package.

**Important:** The steps to install Visual Discovery may vary, depending on your security settings. If required, you can manually install the Vz.cab file referred to in the following procedure by unzipping the file and running setup.exe on the desired machine.

**Reference:** Development Requirements for VZ Web Server

For the development environment you must have:

- **Windows 7 Enterprise, Professional or Ultimate editions, Windows XP Professional, Windows 2003 or 2008 Server editions.**

- **Microsoft Internet Explorer.** Internet Explorer components are required for Developer Studio. Internet Explorer 8 and Internet Explorer 9, 32-bit, are certified for Developer Studio.

- **Apache Tomcat 7.0.33.** The thick client works with Apache Tomcat as both a web server and an application server. IIS can be used as a web server, with Apache Tomcat or another application server supported by WebFOCUS when running with the WebFOCUS Servlet.

**Procedure:** How to Install WebFOCUS Visual Discovery VZ Web Server

2. If it does not already exist, create a \visdis subdirectory under the \ibi_html directory of your deployment WebFOCUS environment.

3. Copy the Vz.cab file and the VzLicense.lpk file to the \visdis subdirectory.

**Procedure: How to Confirm the Vz.cab File Version Number**

Use this procedure when you are migrating from a previous version of Visual Discovery (now uninstalled). If the version of the Vz.cab file is different from before, you must check each Vz.cab file reference in previously created Visual Discovery webpages and update each one to reflect the new Vz.cab file version number.

You can determine the version number of the Vz.cab file by checking the VzLib.dll file.

1. In a program such as Windows Explorer, right-click the VzLib.dll file. By default, it is located in one of the following directories:

   - `drive:\path\ibi\DevStudio81\ibi_html\visdis`
   - `drive:\path\ibi\WebFOCUS81\ibi_html\visdis`

2. From the drop-down list, select **Properties**.
3. Click the **Version** tab to display the current version number of the Vz.cab file.

**Using a WebFOCUS Visual Discovery Page for the First Time**

The first time end users connect to a WebFOCUS Visual Discovery page, they are prompted to install required software. Installing the software is a one-time only step.
Develop your dashboard using HTML Composer in Developer Studio. You can create controls from existing WebFOCUS reports or new reports that you create specifically for your analytical dashboard. When creating controls (graphs) in your dashboard, you must use data sources in VISDIS format.

This chapter covers tasks and options that are available for all Visual Discovery controls (unless otherwise noted). For tasks and options that are graph-type specific, see Visualization Components: Descriptions and Usage on page 113.

In this chapter:

- Creating Visual Discovery Output Files
- Developing an Analytic Dashboard From Developer Studio
- Working With Visual Discovery Controls on the Web
- Accessing Visual Discovery Online Help

Creating Visual Discovery Output Files

Visual Discovery creates graphs using a tab-delimited data file as input. The first record of the data file contains the column titles for the data values. The next record can contain the Visual Discovery field formats. If this record is not present, Visual Discovery attempts to determine the formats of the data fields by reading the first 50 records from the data file, a process that is not guaranteed to create accurate representations of the WebFOCUS formats.

The FORMAT VISDIS option creates a tab-delimited output file with the extension .txt in which the first record has the column titles and the second record contains Visual Discovery formats based on the field formats of the data. A .fex with PCHOLD FORMAT VISDIS can also be created and used the same way as the .txt file.

Reference: Format Conversions for FORMAT VISDIS

<table>
<thead>
<tr>
<th>FOCUS Format</th>
<th>Visual Discovery Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer</td>
<td>I</td>
</tr>
</tbody>
</table>
Creating Visual Discovery Output Files

<table>
<thead>
<tr>
<th>FOCUS Format</th>
<th>Visual Discovery Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal/Packed</td>
<td>R</td>
</tr>
<tr>
<td>Alphanumeric</td>
<td>S</td>
</tr>
<tr>
<td>Date format (smart date)</td>
<td>D%format%format%format (for example, D%Y%m%d). If the year is not a four-digit year, the format returned is S.</td>
</tr>
<tr>
<td>Other</td>
<td>S</td>
</tr>
</tbody>
</table>

**Procedure:** How to Create a Visual Discovery Output File From Report Painter

1. Open Developer Studio.
2. If necessary, create a new project for the report.
3. Add the necessary Master File to your project.
5. Add fields to your report.
6. From the Report menu, select **Output**.
7. From the Output Format drop-down list, expand the Unstyled formats folder and select **Tab delimited text file for Visual Discovery (VISDIS)**.
8. From the Destination drop-down list, select one of the following options:
   a. **Save file** to create a .txt output file.
      
      In the Name field, specify the destination path and name for the file, using the Browse (…) button to navigate the path. This option saves the output as a text file to a physical location on the disk.
   b. **Web browser** to create a .fex with PCHOLD FORMAT VISDIS output file.
      
      This option saves the output as a .fex, which uses live data. Only .fex files that have been saved with PCHOLD FORMAT VISDIS can be used as data for Visual Discovery controls.
9. Click **Apply**.
10. Click **OK** to exit the Report Options dialog box.
11. Save your work and click **Run**.
A new browser window opens with information similar to the following, where 581 is the total number of rows in the data source, and 5 is the total number of rows in the Visual Discovery file:

```
0 NUMBER OF RECORDS IN TABLE= 581 LINES= 5
```

**Syntax:** How to Create a Visual Discovery Output File Using WebFOCUS Language

```
[ON TABLE] HOLD [AS filename] FORMAT VISDIS
[ON TABLE] PCHOLD [AS filename] FORMAT VISDIS
[ON TABLE] SAVE FILENAME 'application_name/filename.txt' FORMAT VISDIS
```

where:

**HOLD**

Creates the results in memory, but does not save them to a text file unless you specify the Dialogue Manager command, APP HOLD `application_name`, in the report request.

For details on HOLD, see the topics on saving and reusing report output in the *Creating Reporting Applications With Developer Studio* manual.

**PCHOLD**

Presents the results as output to a browser. When accessed by Visual Discovery, the procedure is initialized by the ActiveX control using the URL of the procedure. The ActiveX control then interprets the output. Visual Discovery uses a live data pool and does not require a physical output file.

**SAVE**

Creates a physical output file for use when the Visual Discovery page points to a static data pool.

*filename*

Is the name of the output file.

**Note:** A Master File is not created for format VISDIS.
Example: Creating a Visual Discovery Output File Using WebFOCUS Language

Using the CENTURYSALES data source, the following request creates a Visual Discovery output file named AUDIOSYSTEMSSALES.TXT, which is stored in the Visual_Discovery application folder in Developer Studio.

```
TABLE FILE CENTURYSALES
SUM
  QUANTITY
  LINEPRICE AS 'Revenue'
BY PRODUCTCATEGORY
BY PRODUCTNAME
WHERE SALESREP EQ 'Web';
WHERE PRODUCTCATEGORY EQ 'Audio Systems';
ON TABLE SAVE FILENAME
'VISUAL_DISCOVERY/AUDIOSYSTEMSSALES.TXT'
  FORMAT VISDIS
END
```

The following file is created. For clarity, the tab characters in the file are displayed as a greater than sign (>) surrounded by blanks. Note that the first record has the column titles and the second has the Visual Discovery formats.

```
Product Category > Product Name > Quantity > Revenue
S > S > I > R
Audio Systems > Home Theater 5.1 System > 2087 > 4171913.00
Audio Systems > Home Theater 7.1 THX System > 243 > 728757.00
Audio Systems > Home Theater Surround System > 703 > 702297.00
Audio Systems > Micro 5.1 System > 857 > 427643.00
Audio Systems > Micro HiFi Stereo System > 2096 > 836304.00
```

Developing an Analytic Dashboard From Developer Studio

Before you begin to develop your Visual Discovery controls, you create the following objects:

1. The data file. For more information, see Creating Visual Discovery Output Files on page 23.
2. The canvas for your controls, using HTML Composer in Developer Studio. For more information, see How to Create a WebFOCUS Visual Discovery Analytic Dashboard on page 27.

After you create a canvas, and insert a Visual Discovery control, you can begin to edit the control properties. For example, you can select the data, assign colors, show labels, and more. The topics in this chapter cover tasks and options that you may apply to all Visual Discovery controls (unless noted).

Important: When you edit the properties of a control, it is necessary to load the data first, and then select your x-axis field and y-axis field from the loaded data.
For a tutorial on creating a complete Visual Discovery dashboard using sample data, see *Tutorial: Building a Visual Discovery Analytic Dashboard with Advanced Chart Controls* on page 65.

For graph-type specific tasks and options, see *Visualization Components: Descriptions and Usage* on page 113.

**Procedure:**  
**How to Create a WebFOCUS Visual Discovery Analytic Dashboard**

1. Open Developer Studio.
2. From the Developer Studio Explorer, right-click the HTML Files folder in your project folder and select **New**, **HTML File**. The Add HTML File dialog box opens.
3. Enter a name for the file and click **Open**.
4. If the HTML Composer Template selector opens, click **No, thanks**.
5. The HTML Composer canvas opens.

**Note:** Visual Discovery controls are not available if you choose to create an HTML page using templates. You can click the *Don't show again* check box to turn the Template selector off. The next time you create an HTML page using HTML Composer, the Template selector will not appear. For more information, see the *Designing a User Interface for a Web Application With HTML Composer* manual.

6. Click the **Visual Discovery** button on the controls toolbar, or click **Insert**, **Controls**, then **Visual Discovery Control**.
7. Drag your mouse across the canvas to insert the control. The Insert ActiveX Control dialog box opens.

**Tip:** When you insert a control, its size (height and width) defaults to predefined dimensions. However, after you select the type of control from the Insert ActiveX Control dialog box (Step 6), you can change its size using any standard resizing feature.

8. Select a Visual Discovery control and click **OK**.
9. From the Properties and settings dialog box, click **Add Data Pool**. The Get source file dialog box opens.
10. Add data and click **Open**. The selected data will appear in the Available Data Pools drop-down menu.
11. Click **ActiveX Properties** and edit your graph properties as desired.
Naming Controls

When you add a new Visual Discovery control to the HTML Composer canvas, HTML Composer assigns it a default Name and Unique Identifier. The naming convention for the control is activex\(n\), where \(n\) is an iterative number.

For example, when you add the first control, it is assigned the name activex1. When you add the next control, it is assigned the name activex2, and so on.

You can view and modify the Name and Unique Identifier of a control in the Properties pane. If you rename a control, using a more descriptive Name and Unique Identifier, then the next control you add will still increase by 1.

Selecting Data

All components in an analytic dashboard share the same data source. This means that when you select a data source for the first control, that data source is automatically added to the Available Data Pools list, and made readily available for all subsequent controls.

**Procedure:** How to Add and Select Data

1. From the Properties and settings dialog box, click Add Data Pool. The Get source file dialog box opens.
2. Add your data source, a .txt file or .fex file with PCHOLD FORMAT VISDIS, and click Open. The selected data source appears in the Available Data Pools drop-down list.

   **Important:** If you are developing remotely, you must either map a drive to the remote location of the data source or copy the data source to the local machine.

3. Click ActiveX Properties and edit your graph properties as desired. Repeat Step 2 as necessary.
4. Add fields by clicking the box adjacent to the field. Click once to add the x-axis field, click twice to add y-axis field.
5. Click Apply, and then OK.
**Reference:** Properties and Settings Dialog Box

The following image shows the Properties and settings dialog box.

![Properties and settings dialog box](image)

**Available Data Pools**

Enables you to select a data file to use to populate the Visual Discovery control. After you select the file name, and click *ActiveX Properties*, the file is loaded. Its tables and fields display in the tree view panel on the Data tab.

**Add Data Pool**

Enables you to select a data file to use to populate the Visual Discovery control and add it to a list of available data pools.

**Remove Data Pool**

Removes all data sources from Available Data Pools drop-down list.

**ActiveX Properties**

Opens the Visual Discovery Properties dialog box, where you can edit the fields, colors, control features, font style, and titles for a particular Visual Discovery control.

The first tab in the Visual Discovery Properties dialog box is the Data tab. It will guide you on which types of fields, and how many fields you can select.

**Reference:** Data Tab

The following image and brief description of the Data tab is to guide you as to which types of data fields, and how many fields you can select for a particular control.
The bar chart control was used for the example shown in the following image.

![Bar Chart Control Example](image)

**Data Instructions**

The text that appears above the *Size is* drop-down selection menu, on the top-right corner of the Data tab, instructs you on how to select a category field for the x-axis, and one or more category fields for the y-axis.

**Size is**

Determines the method to calculate the size of the glyph. For more information, see *What Is a Glyph?* on page 114

**Note:** When creating Visual Discovery controls in HTML Composer at design time, you select the data source through the Properties and settings dialog box. At run time, this dialog box does not appear. Instead, you can select your data source, .txt files only, through a modified version of the Data tab.

**Reference:** **Data Tab Icons**

The following table shows the possible icons that appear in the Data tab and what they indicate for the field.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Indicates...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>A table with no items colored.</td>
</tr>
</tbody>
</table>
Assigning Color to the Data and the Graph

You can use color to change how your graph displays. You can change the color scale of the glyphs based on a field that you select. For more information, see What Is a Glyph? on page 114. You can also change the colors of the basic graphical elements (such as background color, foreground color, label color, selected variables, and overlay text color) in your graph control.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Indicates...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon 1" /></td>
<td>A table with a field that colors the graph.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon 2" /></td>
<td>The field is a real number.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon 3" /></td>
<td>The field is a real number and colors the graph.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon 4" /></td>
<td>The field is a number (integer).</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon 5" /></td>
<td>The field is a number (integer) and colors the graph.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon 6" /></td>
<td>The field is a string.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon 7" /></td>
<td>The field is a string and colors the graph.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon 8" /></td>
<td>The field is a date.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon 9" /></td>
<td>The field is a date and colors the graph.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon 10" /></td>
<td>An x-axis selected field.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon 11" /></td>
<td>A y-axis selected field.</td>
</tr>
<tr>
<td><img src="image12.png" alt="Icon 12" /></td>
<td>The field is not available for selection.</td>
</tr>
</tbody>
</table>
Procedure: How to Change Graph Element Colors

1. Select the control and click ActiveX Properties.
   The Visual Discovery Properties dialog box for the selected control opens.

2. Click the Colors tab.

3. Select the colors:
   - Using one of the Standard Tool Element Colors options. When you select one of these (Black, Blue, or White), the colors in the Component Element Colors field automatically change to the colors associated with that color scheme.
   - Manually in the Component Element Colors field. For details on each component in the Component Element Colors field, see Colors Tab on page 33.

4. Click Apply, and then OK.
**Reference: Colors Tab**

The following image shows the Colors tab in the Visual Discovery Properties dialog box.

![Colors Tab Image]

**Color Using Field**

These settings apply to the entire Visual Discovery webpage.

**Table**

Specifies the name of the table for the current view. Other tables may be selected, even if they are not shown by the current view, by entering the table name in this field. If you have entered the name before, you may select the arrow key to the right of the entry field and scroll down to the desired name.

**Field**

Names the field in the table that is used to color the graph. If no field is selected, the table is not colored.

**Re-apply color to field**

Reapplies the color scale to a subset of data.

**Color Scale**

Changes the color scale for the graph. See *Coloring a Graph by a Field* on page 36.
**Standard Tool Element Colors**

Changes the background color of the graphs to black (the default setting), blue, or white. A default set of visualization component element colors is automatically selected for each background color.

**Component Element Colors**

**Background**

Specifies the color behind the graph. By default, the background color is black. A default set of element colors is automatically selected to go with the black background. Select this to change just the background color. If you want to change the entire color scheme, select one of the options in the Standard Tool Element Colors section.

**Foreground**

Specifies a data element in the visualization component. For example, sometimes it is the color of the outline of the glyphs.

**Selected**

Specifies the color of the items that are selected. If a color scale has been used, that color scale is used instead of the default selected color if the graph corresponds to individual colored data items.

**Missing**

Specifies the color of values that are missing.

**Goal Lines**

Specifies the color of the visualization component line that you can create and place in bar and line graphs.

**Overlay**

Specifies the color of the label or labels (including text and/or items) and any graphs that may be used to denote the items in focus.

**Shine**

Specifies the color of the outline of the bottom and/or right of the graph objects. It helps provide the appearance of depth to the graph. This applies only to bar chart and line chart graphs.

**View Title**

Specifies the color for the title of the visualization component. You can change the title text from the Titles tab.
**Background2**

Specifies the color of the second background element, if one is available. For example, in the data sheet visualization component, a second background color (by default, gray) is used to make rows of data easier to read.

**Label**

Specifies the color of the static text or graphic that identifies items on a graph. For example, the field names for the x-axis and y-axis in the bar chart, histogram, or line chart graphs.

**Unselected**

Specifies the color of the items that are not selected.

**Border**

Specifies the color of the line that is drawn around glyphs so they stand out from the background. This applies only to bar chart and line chart graphs.

**Overplotting**

Specifies the color of the small tick marks (shown at the top of the graph) that indicate items are plotted on top of or overlapping other items.

This element is available for the bar chart, line chart, and time table graphs.

**Selector**

Specifies the color of the shape, indicated in the Selector Shape section of this tab, used to select items.

**Shadow**

Specifies the color of the outline of the top/left of graph objects. It helps provide the appearance of depth to the graph. This applies only to bar chart and line chart graphs.

**Axis Title**

Specifies the color for the x-axis and y-axis titles.
**Coloring a Graph by a Field**

When you color a graph by a field, you provide another level of meaning to the graph. It is a way to add more information, an additional variable, to the graph. The field you choose to control color is usually based on the type of data you want to analyze and how you want it to appear. Coloring by a particular field helps you study the effect of that field on your data. You can also use color to highlight exceptional values (for example, the high values in a distribution), as well as categories of values.

Coloring depends on the color scale you select. For example, the Rainbow color scale ranges from blue to red. Color is uniformly applied as a continuous scale across the entire range of values in that column. Colors are assigned from low to high for numeric values and in alphabetical order for string values.

**Procedure: How to Color a Graph by a Selected Field**

1. Select the control and click *ActiveX Properties*.
   
   **Note:** If you are selecting colors for a bar chart, histogram, line chart, or pie chart that has more than two fields, make sure the Stack Colors check box is selected on the chart-specific tab.

2. Click the *Colors* tab.

3. In the Color Using Field, ensure the correct data pool is selected from the Table drop-down list.

4. From the Field drop-down list, select the field you want to color the graph by.

5. In the Color Scale field, select the color scale:

   - *Green/Red* goes from green on one end to red on another. This color scale uses the stop light metaphor (green means go or OK, yellow means caution, and red means stop or immediate attention).

   - *Pastel* is a red to blue scale using pastel shades.

   - *Equalized* is an alternate scale with equal perceptual changes between each entry in the scale.

   - *Categorical* is a field for which the values represent categories or classes. Categorical variables do not have natural scale or units of measurement. A field containing country names, such as the United States, United Kingdom, and Germany, is categorical.

   - *Rainbow* is the common red-to-blue scale. This is the default.
Gray enables unselected items to be shown in gray, making them seem to fade from view. The Gray color scale uses shades of black and white, instead of a set of colors, to show differences or similarities between/among items.

Thermal mimics the color changes in a heated iron, from cold (black) through warm (yellow) to extremely hot (white).

Smallest Values are High Priority. By default, the highest values are set to the highest priority. This means that the values are assigned a color based on the placement of the value within the selected color scale. The highest value is at one end of the color scale and the lowest value is at the other end. By selecting this option, the coloring of the values is reversed.

6. Click Apply, and then OK.

**Note:** When you select a subset of data and exclude the unselected items, you might want to apply the color scale to the range of values in the subset instead of it remaining applied to the entire set of data. If the remaining items (the subset) are from the same area of the original data set, the colors of all the items might be very similar. If you reapply the color just to those remaining items, each item might stand out more because the color scale is applied to a smaller range.

To reapply the color scale to a subset of data, select *Re-apply color to field* in the Color Using Field section and click *Apply*.

**Values are VisDis Color By**

Another way to color your Visual Discovery controls is through an HTML Composer Visual Discovery integration feature called Values are VisDis Color By. Values are VisDis Color By is an option only available through the Properties and settings dialog box of a list box, drop-down list, or double list box. You must first create a canvas using HTML Composer, add a Visual Discovery control, and then add a list box, double list box or drop-down list that contains the field names from the data pool of the Visual Discovery control.

When you run the HTML page, you are able to select a field name from the list to change the colors of the Visual Discovery control.

**Procedure: How to Color a Visual Discovery Control Using Values are VisDis Color By**

The following procedure provides the steps to color a Visual Discovery control using the Values are VisDis Color By option.

1. In HTML Composer, create a Visual Discovery control, such as a bar chart.
2. Select a data pool, and the desired x-axis field and y-axis field for the control.

3. From the Insert menu, select Controls, then click Drop Down List.

   **Note:** You may also choose a list box or a double list box instead of a drop-down list.

4. Click and drag your cursor across the canvas. The drop-down list appears.

5. With the drop-down list selected, click the Parameters tab in the lower-left corner of the HTML Composer window.

   The Properties and settings dialog box appears, as shown in the following image.

   ![Properties and settings dialog box](image)

   **Note:** If the Properties and settings dialog box does not appear, you must select it from the View menu.

6. Select Static from Data type radio button area.

7. Click the Values are VisDis Color By check box at the bottom of the dialog box.

   **Note:** The Values are VisDis Color By check box only appears when Visual Discovery controls are on the HTML page.
8. Click the New button drop-down list, click *Visual Discovery ActiveX*, the name of your Visual Discovery control that contains the fields to be used as color by values, and then select a field name option from the cascading menus, as shown in the following image.

The New button drop-down list changes to allow the selection fields from data pools, only when you have clicked the Values are VisDis Color By check box.

9. Repeat Step 6 for a second field name option of your choice.

You can also click *Add All Items*, which adds every available field name option to the drop-down list control.

10. Click the *Design* tab located in the lower-left corner of the HTML Composer window.

11. Save your work, and Run the page.
When you run the HTML page, select a field from the drop-down list. Notice that the colors of your Visual Discovery control are now colored according to the selected field.

**Choosing Selection Options**

In interactive data visualization controls, selection enables you to retrieve data of interest (and effectively answer questions about the data) just as written queries do. However, many of the methods to visually select data are different from written queries. Since all controls in your dashboard share the same data pool, when you select data in one control, the same data is selected in all controls.

You select by sweeping an area of the interactive data visualization control with the mouse and clicking on items. Additionally, in the data sheet control, you can perform textual selection.

The Selecting tab controls how selection with the mouse works. These properties affect all views, not just the current view. In addition to selecting a group of items with the mouse, you can also select, unselect, exclude all data, and toggle the selection states using the pop-up menu.

**Note:**

- The data constellation control has specific selection features. For more information, see *Data Constellations* on page 141.

- Although all selector shapes can be selected on the tab, only the rectangle is allowed as a selector shape for 3D controls.
**Reference: Selecting Tab**

The following image shows the Selecting tab in the Visual Discovery Properties dialog box.

![Selecting Tab Image](image)

**Selector Shape**

**Rectangle**

The default shape used to select items. To select or sweep using a rectangle, move the cursor to one corner to the desired data, press and hold the left mouse button, move the cursor to the opposite corner of the desired area, and release the mouse button. The data within the rectangle is selected.

**Lasso**

When Lasso is selected, you may draw a free style curve. When the left mouse button is pressed, the lasso follows the cursor and selects items the cursor passes until the mouse button is release.

**Circle**

When Circle is selected, it enables you to sweep or select data within a circle whose center is the position where the left mouse button was initially pressed, and the perimeter is where that mouse button is released. When the Circle selector shape is active, a dot appears in the small circle next to the text.

**Rectangular Brush**

When Rectangular Brush is selected, a rectangle follows the mouse and identifies objects that it passes over.
**Circle Brush**

When Circle Brush is selected as the selector shape, a circular shape follows the mouse and identifies objects that it passes over.

**Interactive Labeling**

**Details**

Options include the following. Note that details cannot be presented in a histogram because the histogram displays the distribution of single continuous fields. Individual values are not shown.

**Hover or Shift.** The detailed information about a glyph appears when you hover over or move the cursor over an item while holding down the Shift key. This is the default.

**Hold Down Shift.** Turns on the detailed information when you press the Shift key and pass over the items. When you are not over an item, the option turns off until you press the Shift key again.

**Continuous.** When you pass over an item, the detailed information appears about that item.

**Location**

Options include:

**Continuous.** The coordinates (location on the x-axis and y-axis) of a glyph appear when you move the cursor over the item. This is the default.

**Hover or Shift.** When you hover over or move the cursor over an item while holding down the Shift key you see the coordinates for that point.

**Hold Down Shift.** Turns on the location information when you press the Shift key and pass over the items.

**Flicker Free Drawing**

When the cursor moves over a graph, it may cause flickering. Select this option to eliminate the flicker. Graphs may take longer to render with this option set.

**Selector Operation**

**Replace**

Replaces the existing selection set with the next items identified.
**Toggle**

Reverses the selection state of items. Selected items become unselected. Unselected items become selected.

**Add**

Select this option to add identified items to the selection set.

**Subtract**

Removes identified items from the selection set, if they are in it.

**Intersect**

Selects only those items that were previously selected and are in the set of identified items.

**Specifying Fonts and Titles**

The Fonts tab sets the font type and size for the view title (the title for the control or graph, which you set in the Titles tab), the axis titles, and the labels. The Titles tab sets the titles of the view (the graph) and the axes of the graph.

**Reference: Fonts Tab**

The following image shows the Fonts tab in the Visual Discovery Properties dialog box.

![Font Tab](image)

To change the font, font style, or font size, click the appropriate Font button.
**Reference: Titles Tab**

The following image shows the Titles tab in the Visual Discovery Properties dialog box.

![Titles Tab Image]

Type the titles in the Title Text field. If you do not alter the titles, they will default to the field names from the data table you selected in the Data tab.

This tab is not available for the counts, data sheet, parabox, or time table controls.

**Using Goal Lines**

You can use goal lines in a bar or line chart.

Goal lines are lines you can place on a bar or line chart in the report output. Goal lines display in front of the graphed data, enabling you to compare your data with one or more set values. You can see which values are above or below a level you specify.

Before selecting glyphs above or below a goal line, negative and positive values are added. If your graph contains negative and positive numbers, some glyphs that you may initially expect to appear above or below the goal line (depending on which button you select), may have a cumulative value different than you might expect and the glyph will not be selected.

**Note:** Goal lines are not available when what you are using a spine plot, since the bar glyphs are the same height.

**Procedure: How to Add Goal Lines**

1. Ensure Show Goal Lines is selected on the bar chart or line chart pop-up menu.
2. From the pop-up menu, select Create Goal Line. A blue line appears.
3. Repeat Step 2 for each desired goal line.

**Procedure: How to Move Goal Lines**

Select a goal line and drag it to the desired value. Use the focus information to position the goal line.

**Procedure: How to Hide Goal Lines**

From the pop-up menu, clear the check mark for Show Goal Lines.

*Note:* This does not permanently remove the goal line from the graph.

**Procedure: How to Remove Goal Lines**

1. Move the cursor over the goal line.
2. Click the close (X) button.

**Procedure: How to Select Values Above/Below the Goal Line**

1. Move the cursor over the goal line.
2. Click the:

   - *Up button* to select all values above the goal line.
   - *Down button* to select all values below the goal line.

   The graph changes to reflect your selection.

**Animating Data**

You can animate data in a bar, line, or pie chart.

Animation is when each glyph is sequentially highlighted and then restored to its original state. Animation is especially helpful when you are analyzing two or more interactive data visualization controls at the same time because you can easily see the highlighted items in all displayed controls simultaneously. Animation is also helpful when you are viewing complex data because it can highlight unexpected relationships.

When you set and control animation in a control (bar chart, line chart, and so on), the animation effect occurs in all the displayed controls that use the same data source.
Procedure: How to Animate a Bar, Line, or Pie Chart

1. In the Visual Discovery Properties dialog box, click the chart-specific tab (either the Bar Chart tab, Line Chart tab, or Pie Chart tab).
2. Select the Animate check box and click Apply.
3. To control animation, click the:
   - Backward button to go back one bar. Backward does not reverse animation.
   - Pause button to temporarily stop animation.
   - Resume button to restart the animation after it has been paused.
   - Forward button to go forward one bar. Forward does not restart animation.
4. To change the speed of animation, click:
   - Slower to slow down animation place.
   - Faster to speed up animation.
   - Normal to return the animation to the default pace.

Tip: From the pop-up menu, select Animate.

Selecting Primary and Secondary Order

You can select primary and secondary order in a bar, line, or pie chart.

Order controls the sequence in which glyphs are presented. You can select primary and secondary order in bar, line, and pie charts.

Procedure: How to Select Primary and Secondary Order

1. In the Visual Discovery Properties dialog box, click the chart-specific tab (either the Bar Chart, Line Chart, or Pie Chart tab).
2. In the Order field, from the Primary drop-down list, select:
   - Original order to show the order in which the data was initially presented. This is the default.
   - Label order to alphabetize the data by category name.
Size to display the categories by the number of cases (from the largest count to the smallest).

Total Selected to display the categories by the number of cases selected.

% Selected to display the categories by the percentage of cases in that category that are selected.

Note: The Primary drop-down list and the Secondary drop-down list contain the same options.

3. Select the Secondary order option.

Secondary order is applied at the same time as the primary order and becomes apparent only when two or more items have the same value according to the primary order.

4. Click Apply, and then click OK.

Note: On the pop-up menu, click Primary Order and then select an option.

Displaying Labels

You can display labels in a bar, line, or pie chart.

You can choose how and which labels to display in the control when you are creating the control.

You can also show and hide individual labels using the pop-up menu.

Note: X-axis and y-axis labels come from the field names in your data source.

Procedure: How to Select Label Mode

1. In the Visual Discovery Properties dialog box, click the chart-specific tab (either the Bar Chart, Line Chart, or Pie Chart tab).

2. Select the desired option from the Labels Shown drop-down list. Options include:
   - Best Fit displays labels in equally spaced increments. This is the default option.
   - Selected displays labels for the selected (colored) data only.
   - All displays labels for all data on the graph.
   - Off displays no labels.
   - Custom enables you to select which labels to display.
3. Click **Apply**, and then click **OK**.

**Tip:** From the pop-up menu, select **Label Mode** and then select the desired option.

**Procedure: How to Show or Hide Individual Labels Using the Pop-up Menu**

1. Right-click the label you want to show or hide.
2. Select Label 'name' from the menu.

**Preselecting Values**

You can preselect values of a Visual Discovery control that display at run time, by adding the onInitialUpdate() function to the Embedded JavaScript tab of HTML Composer. When you run the HTML page, the values you preselected display.

**Procedure: How to Preselect Values**

1. In HTML Composer, create a Visual Discovery control, such as a bar chart.
2. Select a data pool, and the desired x-axis field and y-axis field for the control.
3. Click the **Embedded JavaScript** tab.
4. Below **//End function window_onload**, create the onInitialUpdate() function that calls the IbComposer_setCurrentSelection() JavaScript API function. Specify the necessary parameters to preselect and display values at run time.

An example of the onInitialUpdate() function code, with two preselected values, is shown in the following image.

```javascript
//Begin function window_onload
function window_onload() {  
UpdateData();

// TODO: Add your event handler code here
//add onInitialUpdate() function to make changes before initial run of the reports
}
//End function window_onload
function onInitialUpdate()  
{  
var arrValues = [];  
arrValues.push('Scone');  
arrValues.push('Mug');  
IbComposer_setCurrentSelection('activex1', arrValues, false);  
}
```

5. Run the page.
When you run the page, the preselected values will display on the Visual Discovery control, as shown in the following image.

![Dollar Sales per Product]

**Passing Between a Report and a Visual Discovery Control**

Using HTML Composer, you can add custom parameters that pass data between Visual Discovery controls and reports on a webpage. You can build a webpage in which a Visual Discovery control passes data to a report, or a webpage in which a report passes data to a Visual Discovery control. Each option requires use of the same data pool.

**Procedure: How to Pass a Parameter From a Visual Discovery Control to a Report**

The following procedure provides steps to create a Visual Discovery control parameter that passes data to a report at run time.

1. Create a parameterized procedure that shares the same values as the data pool you select for your Visual Discovery control.
2. In HTML Composer, create a Visual Discovery control, such as a bar chart.
3. Select a data pool, and the desired x-axis field and y-axis field for the control.
4. From the Insert menu, click *New Report*.
5. Click and drag your cursor across the canvas. A report placeholder opens.
6. Right-click the report placeholder and select *Reference existing procedure*. 
The Get source file dialog box opens.

7. Navigate to the parameterized procedure you created in Step 1, and click Open.
   The New Parameters dialog box opens.

8. Click the ellipsis button under Control Type.
9. Click Existing control, and the name of your control.
11. Save your work and then run the webpage, as shown in the following image.

   ![Bar chart showing unit sales per product]

Select specific data in your Visual Discovery control, and click the Run button to view the report results, as shown in the following image.

   ![Updated bar chart after data selection]
**Procedure:** How to Pass a Parameter From a Report to a Visual Discovery Control

The following procedure provides steps to create a report parameter that passes data to a Visual Discovery control at run time.

1. In HTML Composer, create a Visual Discovery control, such as a bar chart.
2. Select a data pool, and the desired x-axis field and y-axis field for the control.
3. Click the *Parameters* tab.
4. Right-click the page and select *Add parameter*.
   
   The parameter Properties and settings dialog box opens.

5. Type a parameter name in the Name Field.
   
   **Note:** The same parameter name will be used in the report.

6. Select the new parameter, and create a binding line to your Visual Discovery control, as shown in the following image.

7. Select the arrow on the binding line.
   
   A new Properties and settings dialog box opens, as shown in the following image.

8. Click the ellipsis button and select the datapool field that should be selected based on the parameter created in Step 2.

9. Save your work and close HTML Composer.

   Once you have created the HTML webpage with a Visual Discovery control, you must then create a report that will pass data to the Visual Discovery control.
10. Open Report Painter to create a new Report using the same Master File as your data source.

11. Select the Report fields.

12. Right-click the field on the Report Painter canvas whose value should be passed to the Visual Discovery HTML page, and click Options.

   The Field Properties for Field dialog box opens, as shown in the following image.

   ![Field Properties for Field dialog box](image)

13. Click the Drill Down tab.

14. On the Active Object drop-down list, click Column Data.

15. On the Drill Down Type drop-down list, click URL.

16. Type the fully qualified URL to your HTML page.

17. Under With Parameters, click Add.
The Drill Down Parameter dialog box opens, as shown in the following image.

18. Type the same parameter name that you selected in Step 2, and click OK.
19. Click OK to close the Drill Down Parameter dialog box.
20. Click OK to close the Field Properties for Field dialog box.
21. Save your work and run the report.

**Note:** When you run the report, the chosen parameter field appears with underlined text, as shown in the following image.
Click an underlined text field. Notice that the Visual Discovery control you created earlier appears with the appropriate parameter selected, as shown in the following image.

For more information, see the Designing a User Interface for a Web Application With HTML Composer manual.

**Chaining Into a Visual Discovery Control**

Using the HTML Composer chaining feature, you can integrate Visual Discovery controls and data within a listbox, double list, or drop-down list. Adding this functionality to your dashboard creates an interactive webpage from which end users can select values in the list and automatically view them in a Visual Discovery control.

**Procedure: How to Chain Into a Visual Discovery Control**

1. Create a parameterized, PCHOLD FORMAT VISDIS procedure that contains a multi-select parameter and the fields you want to be displayed in the Visual Discovery control.

   **Note:** Because a Visual Discovery control is always multi-select, you must always use a multi-select parameter.

2. In HTML Composer, create a Visual Discovery control, such as a bar chart, using the parameterized procedure you created as the data pool.

3. Create a list box that will display the values you want shown in the Visual Discovery control.
4. In the Properties pane, change the Multiple option to *Multiple*.
5. Click the *Parameters* tab.
6. Remove the multi-select parameter from the unbound box, as shown in the following image.

![Diagram](image1.png)

7. Bind your list box to the multi-select parameter and the Visual Discovery control, as shown in the following image.

![Diagram](image2.png)

8. Save your work and run the webpage.
The HTML page shows your list box, populated with the values, and your Visual Discovery control, as shown in the following image.

Selecting values from the list box will display data in the Visual Discovery control, for those values only. The following image shows three values selected with the corresponding data displayed in the Visual Discovery control.
Excluding and Restoring Data

In addition to the Visual Discovery selection features at run time, you can use the exclude and restore hyperlink actions to link Visual Discovery controls and button controls on a webpage. With this option, end users can select data on a control and click the Exclude button to view only the selected data. To restore the unselected data, end users can click the Restore button.

Procedure: How to Exclude and Restore Data

1. In HTML Composer, create a Visual Discovery control, such as a bar chart.
2. Select a data pool, and the desired x-axis field and y-axis field for the control.
3. Create two push buttons on the page with your Visual Discovery control.
4. Right-click the first button and click Create hyperlink.
   The Hyperlink Properties dialog box opens, as shown in the following image.

5. In the Display Text field, type Exclude.
6. Click the new hyperlink button.
7. Edit the properties of the new hyperlink.
   - Select Visual Discovery Exclude from the Action drop-down list.
   - Select your controls data pool from the source drop-down list.
8. Click OK to close the Hyperlink Properties dialog box.

9. Repeat Steps 3 through 7 for the second button, noting the following:
   - Name the button Restore and click Visual Discovery Restore from the Action drop-down list.

10. Save your work and run the webpage.

   When selecting data from the Visual Discovery control, you can click the Exclude button to hide all of the unselected data, as shown in the following images.
When you click the Restore button, the hidden data is brought back.

**Working With Visual Discovery Controls on the Web**

Anyone viewing Visual Discovery analytic dashboards on the web can alter the selection of data or the display of controls without requiring Developer Studio or any programming skills. You can select data, restore excluded data, change the display, such as orientation or sort order, or save the control as a GIF image for use in an external report.

**Selecting Data**

On your Visual Discovery analytic dashboard on the web, click inside a control and drag your cursor until part of the data is captured by an outline. Release the cursor to complete the selection. You will see the selection change the appearance not only of the control in which you made the selection, but in all the Visual Discovery controls on the dashboard.

To change the shape of the selection tool, select the control and click *ActiveX Properties*. Click the *Selecting* tab and choose a new selector shape. For more information, see *Selecting Tab* on page 41.

**Restoring Excluded Data**

Once you have selected data on your Visual Discovery analytic dashboard on the web, the excluded data is grayed out or simply not present, depending on the options preselected by the Dashboard creator. If the excluded data is grayed out, you can restore it in the following ways:

- Clicking a gray section replaces the current selection.
- Pressing Ctrl + click adds the new section to the current selection.
- Dragging the selector shape across the control selects a new set of data.

If the excluded data disappears from the control, you can restore it by:

- Selecting the grayed-out data in another control.
- Right-clicking the control and selecting *Show unselected* to keep the selection area the same while displaying unselected data.
- Right-clicking the control and selecting *Select*, then *Select All* to restore all data to the selection.

**Changing the Display**

To change the orientation, label display, sort order, or glyph choice for any Visual Discovery control, right-click the control and select the appropriate item. For pie charts, you can also change the rotation, the measure of explosion, or the weighting.
For access to the complete set of control options, right-click the control and click Properties.

**Saving a Control as an Image**

To save a control as an image, right-click the control and click Save image. Specify the destination and file name to save the control as a GIF file.

**Saving the State of Analysis**

A bookmark is a combination of display characteristics, such as the selection state (data that is selected, unselected, or excluded) and the colors used in the control. The Visual Discovery bookmark feature allows you to save a specific state in your analysis, so you can return to it at a later time without recreating it from the beginning.

To save the current state of your analysis, select the control, click ActiveX Properties, and access the BookMarks tab in the Visual Discovery Properties dialog box. In the input field, type a name for the bookmark and click Create and OK. The new bookmark will be available from the Bookmarks option on the pop-up menu for the control.

**Reference: BookMarks Tab**

The following image shows the BookMarks tab in the Visual Discovery Properties dialog box.

- **Create**
  
  This bookmarks the current view of the control on a webpage so that you can return to it at a later date. Type a name and click Create.
Go To
Select a bookmark and click Go To to return to that view of the control.

Remove
Select a bookmark and click Remove to delete the bookmark.

Accessing Visual Discovery Online Help
The Visual Discovery design-time and run-time environments provide online Help for the user interface and the JavaScript API. The JavaScript API online Help includes full documentation on all controls and their properties, methods, and expected behavior.

Procedure: How to Access Visual Discovery Online Help
This procedure describes how to access online Help for the user interface, and then navigate to information on the JavaScript API.

For specific steps on using online Help to set colors, see the example that follows this general procedure.

1. In the design-time environment, select the control whose properties you are setting and click **ActiveX Properties**.

   In the run-time environment, right-click the control and click **Properties** from the pop-up menu.

   The Visual Discovery Properties dialog box for the selected control opens.

2. Click the **Help** button in the lower-right corner of the dialog box.

   The Common Property Pages window opens. It provides information on all the tabs for the control. These common tabs are the same for many controls.

3. Scroll down the page to locate information on the tab that you are interested in.

   Online Help information explains what the fields on the tab allow you to do.

4. On the Search tab in the left pane, in the field labeled Type in the keyword to find, enter a search string and click **List Topics**.

5. Select the topic that applies and click **Display**.

   A new pane opens on the right, displaying the selected topic.

6. Scroll down the pane, following the highlighted instances of the keyword you entered until you come to the information you are looking for.

7. When you have retrieved and reviewed the information, close online Help to return to the Visual Discovery control.
Using Visual Discovery Online Help to Set Colors

You can set the color of the various parts of a control, for instance, the background, the axis titles, the chart title, and so on. This example shows how to access online Help for information on the Colors tab of the user interface, then navigate to information on setting colors through the JavaScript API.

This example uses an HTML page with a bar chart. It accesses online Help from the design-time environment.

1. Open the HTML page in design mode in HTML Composer.
2. Select the bar chart control, whose color properties you are setting, and click ActiveX Properties.
   The Visual Discovery Bar Chart Properties dialog box open.
3. Click the Help button in the lower-right corner of the dialog box, as shown in the following image.

   ![Visual Discovery Bar Chart Properties](image)

   The Common Property Pages window opens. It provides information on all the tabs for the bar chart.
4. Scroll down the page to locate information on the Colors tab.
   Online Help information explains what the fields on the tab allow you to do, for example, apply a color to a control element, such as background.
5. In this example, we would like to know more about setting colors and additional color capabilities available through the JavaScript API.
On the Search tab in the left pane, in the field labeled *Type in the keyword to find*, type *Background Color* and click *List Topics*, as shown in the following image.

6. Click *IVZView4* and click *Display*.

The VzView4 window opens in the right pane, with details on the standard JavaScript API for all Visual Discovery controls, including properties and methods.

Instances of the keyword you entered in the search pane are highlighted (background color and color).
7. Scroll down the right pane, following the highlighted instances of background color or color, until you come to the color properties, as shown in the following image. Here you find that a color is encoded as a string that gives the RGB (red/green/blue) value in hexadecimal notation (0xRRGGBB). For example, red is 0xFF0000 and blue is 0x0000FF.

Tables describing hexadecimal color codes are available on many websites.

8. Close online Help to return to the Visual Discovery control.
This chapter provides a two-part tutorial for building an analytic dashboard with Visual Discovery controls, and a sample chart control interface that enables you to change, at run time, the method of data selection being used.

The first part covers some of the most commonly used chart types and useful Visual Discovery add-ons. The second part allows you to create controls that can be customized for future applications, as well as creating an active report or PDF from the selected components.

For a complete description of all Visual Discovery controls, see Visualization Components: Descriptions and Usage on page 113.

**In this chapter:**

- Before You Begin
- Building an Analytic Dashboard With Visual Discovery Components
- Building an Application With Advanced Chart Controls

**Before You Begin**

This tutorial assumes that you are already familiar with WebFOCUS Developer Studio and that you have done the following:

- Installed WebFOCUS Developer Studio.
- Confirmed that Developer Studio is connected to its internal WebFOCUS Reporting Server or to a remote WebFOCUS Reporting Server.
- Confirmed the use of Internet Explorer 8.0 or higher.
- Reviewed Visual Discovery documentation and learned how to create Visual Discovery .txt files (FORMAT VISDIS) and .fex files (PCHOLD FORMAT VISDIS).
- Reviewed the topic on designing a user interface for a web application with HTML Composer in the Designing a User Interface for a Web Application With HTML Composer manual.
Building an Analytic Dashboard With Visual Discovery Components

This section of the tutorial illustrates how to create an analytic dashboard that contains two bar charts, a data constellation, a pie chart, and a summary sheet. The first four controls show revenue by different values (store, region, city, product type). The last control (summary sheet) shows various values (quantity, returns, and revenue) for each sales representative. The data constellation is placed on top of a map of the United States.

The final output of this section should look similar to the following image.

---

**Note:** On any webpage, colors and appearance can vary slightly from machine to machine. Visual Discovery is particularly sensitive, because it is an ActiveX object. Consequently, the images included in this tutorial may appear slightly different from the result you achieve.

Visual Discovery controls use data from a .txt or .fex (with PCHOLD FORMAT VISDIS) output file. To understand how to create this type of file, see *Developing an Analytic Dashboard* on page 23. You create analytic dashboards using HTML Composer, which you can access from:

- The Developer Studio project area.
- WebFOCUS Environments: Data Servers.
WebFOCUS Environments: Repository.

**Tip:** As you perform the steps in the tutorial, save your work frequently.

*Procedure: How to Create the HTML File*

1. In your project or application folder, right-click the HTML Files folder and click New, then select HTML File.
   
   If you are working in the Repository, right-click a folder and select New, HTML File.

2. Enter vzMySales as the file name and click Open.
   
   If the Template Selector opens, click No, thanks to close it.
   
   HTML Composer opens, as shown in the following image.

   ![HTML Composer](image)

*Procedure: How to Create the Bar Charts*

1. Click the Vis (Visual Discovery) button on the components toolbar.

2. Drag your cursor across the canvas. The Insert ActiveX Control dialog box opens.

3. Click Visual Discovery Bar Chart and click OK.
4. Click the **Empty Bar Chart** component. The Properties and settings dialog box opens. You need to associate data with the control before specifying the characteristics of the bar chart.

5. Click **Add Data Pool** in the Properties and settings dialog box.

6. Navigate to your data file and click **Open**. In this example, we are using a file named vzstoresales.txt. You can copy this file to your current application from the \ibi\apps\session directory.

7. Click **ActiveX Properties** to open the Visual Discovery Bar Chart Properties dialog box.

8. In the Data tab, expand the data tree to see the available fields. The bar chart in this example uses the Revenue and Store Name fields.

9. Click:
   - **Once on Store Name** so an X appears in the box. This is the x-axis field.
   - **Twice on Revenue** so a Y appears in the box. This is the y-axis field.

The following image shows the x-value and y-value selected in the Data tab.

![](image)

10. Click the **Bar Chart** tab, as shown in the following image.
- Confirm the orientation of the chart is set vertically by clicking the first icon in the Orientation field.
- Set Labels Shown to All, as shown in the following image.
11. Click the Colors tab, as shown in the following image. In the Field list, click Product Type. This colors the bars according to the values in the Product Type field.
12. Click the **Fonts** tab, as shown in the following image.

For Label Font, click the **Font** button and set the font to 10, as shown in the following image.
13. Click the Titles tab, as shown in the following image. Change the following:

- Title Text to Revenue by Store.
- X axis title to blank (no title).
- Y Axis title to Revenue.

![Visual Discovery Bar Chart Properties](image)

14. Click Apply and then click OK to return to the HTML Composer window.

15. Save your work.

16. Access the Properties pane on the right (if needed, click Properties on the View menu).

   From the Properties drop-down list, select activex1 <OBJECT>, if not already selected. For information on the way that Visual Discovery names components, see Naming Controls on page 28.

   Specify the attributes as follows and then save your work:

   - Name: vzBarOne
   - Position: Left: 10px
   - Position: Top: 70px
   - Size: Height: 245px
Tip: You do not need to enter px for pixels. That is the default value.

The following image shows the Properties pane.
17. Run the webpage. The output should look similar to the following image.

![Revenue by Store](image)

18. Close the webpage to return to HTML Composer.

19. Create another bar chart component by repeating Steps 1 through 18 in this procedure. When you create the second bar chart, note the following:

- The vzstoresales.txt data source is already part of the data pool.
- From the Data tab, select Region as the x-axis field, then select Revenue as the y-axis field.
- From the Bar Chart tab, set Labels Shown to All.
- From the Titles tab, change the title text to Revenue by Region and leave the x-axis title blank.
On the Properties pane, remember to select activex2 <OBJECT> from the drop-down list, if not already selected. Set these attributes as follows, and then save your work:

- Name: vzBarTwo
- Position: Left: 220px
- Position: Top: 70px
- Size: Height: 245px
- Size: Width: 280px
- Unique Identifier: vzBarTwo

20. Run the webpage. The output should look similar to the following image.

21. Close the webpage to return to HTML Composer.
Procedure: How to Create the Data Constellation

1. Insert another Visual Discovery control.

2. This time, click *Visual Discovery Data Constellations*.
   
   We are going to bring in a map with dimensions of about 512 x 256.

3. Click the *Empty Data Constellations* component, then select vzstoresales.txt from the Available Data Pools list on the Properties and settings dialog box.
   
   In the Properties and settings dialog box, note that the data source is already available in the Available Data Pools list since you added it for the bar charts. Visual Discovery controls share the same data pool. If you want to add additional data, you can add more tables here.

4. Click *ActiveX Properties*. The Visual Discovery Data Constellations Properties dialog box opens.

5. In the Data tab, expand the data tree and select *City*.

6. Click *Apply*.

7. Click the *Data Constellations* tab, as shown in the following image. In the:
   
   - Label area, select the *Label selected* check box.
   
   - Node and Link Selection area, select *Nodes Only* and *No Linking*. This shows only the specific cities as data points (nodes) and does not link the nodes.
Uncheck Show Unselected. When the webpage runs, all the glyphs that are not selected are removed.

8. Click the Nodes/Links tab, as shown in the following image. In the Nodes area:
   - In the Label list, click City.
   - In the Height list, click Revenue.
   - Move the Scale slider to the right to increase node size.
This labels all of the data points (nodes) with the value in the City field and determines the height of the node from the value in the Revenue field. It also scales the nodes so that they are visible on the map.

9. Click the **Placement** tab. Add the map image and the coordinates for longitude and latitude. In the Position File input area, three distinct parameter strings are required, each separated by a space, as follows:

```
longfield, latfield 'imagepath' minmax1~ minmax2
```

where:

- **longfield, latfield**
  
  Are the actual names in the data source for the fields that contain the X,Y (longitude and latitude) coordinates for the nodes, respectively.

- **'imagepath'**
  
  Is the full path of the map image. Use the Browse button to enter this value.

- **minmax1~ minmax2**
  
  Are the minimum X and Y (lower-left corner of the map) and maximum X and Y (upper-right corner of the map) values, separated by a tilde (~) and a space.

  a. In the Position area, click the map position image (the first image in the second row).
b. Click Browse and navigate to the map file. In this example, we are using a file named usMainlandDark-125.5+23.5-67+50.jpg. Change the Files of type drop-down list to All Files, then copy this file to your current application from the \ibi\apps\session directory.

c. Click the Position File text box and preceding the image path, enter the field names for the X, Y (longitude and latitude) coordinates. Ensure there is a space between Latitude and the path designation. For example:

```
Longitude,Latitude 'C:\ibi\apps\session\usMainlandDark-125.5+23.5-67+50.jpg'
```

d. In the Position File text box, go to the end of the string. Add the minimum X and Y and maximum X and Y values. Ensure the values are separated by a tilde (~) and a space, for example:

```
Longitude,Latitude 'C:\ibi\apps\session\usMainlandDark-125.5+23.5-67+50.jpg'-125.5,23.5~ -67,50
```

The following image shows the Placement tab.

10. Click the Colors tab. Confirm that Product Type is selected from the Field drop-down list for Color Using Field. This colors the nodes by the values in the Product Type field.
11. Click the 3D tab, as shown in the following image. Select Parallel from the Projection field.

12. Click the Fonts tab.

   For Label Font, click the Font button and set Size to 9.

13. Click the Titles tab and for the Title Text, enter Revenue by City.

   Confirm that Show view title is checked.

14. Click Apply, and then click OK. Save your work.

15. Access the Properties pane on the right. From the drop-down list, select activex3 <OBJECT>, if not already selected.

   Specify the following values and then save your work:

   - Name: vzMap
   - Position: Left: 10px
   - Position: Top: 325px
   - Size: Height: 365px
   - Size: Width: 605px
   - Unique Identifier: vzMap
16. Save your work.

17. Run the webpage. The output should look similar to the following image.

![Revenue by Store](chart1.png)

![Revenue by Region](chart2.png)

![Revenue by City](chart3.png)

18. Close the webpage to return to HTML Composer.

19. To enable handles on the map, which allows you to rotate the image during run time, change the data constellation 3D projection setting to **Perspective**.

   To change the 3D projection setting:
   - Run the form.
Right-click on the map and click Properties.

Click the 3D tab, and then click the Perspective radio button.

Drag the handles at the corners of the map to rotate the image.

**Procedure: How to Create the Pie Chart**

1. Insert another Visual Discovery control and click Visual Discovery Pie Chart.
2. Click the Empty Pie Chart component, and then select vzstoresales.txt from the Available Data Pool list.
3. Click ActiveX Properties.
4. In the Data tab, expand the data tree and click:
   - Once on Product Type so an X appears in the box. This is the x-axis field.
   - Twice on Revenue so a Y appears in the box. This is the y-axis field.
5. On the Pie Chart tab:
   - Set Rotation to 45.
   - Set Labels Shown to All.
The following image shows the Pie Chart tab.

![Pie Chart tab screenshot]

6. Click the **Titles** tab and change the Title Text to *Revenue by Product Type*. Confirm that the following is checked: Show view title.

7. Click **Apply**, and then click **OK**.

8. Save your work.

9. Access the Properties pane on the right. From the drop-down list, click *activex4 <OBJECT>* if not already selected.

Specify the following values and then save your work:

- **Name**: vzPie
- **Position**: Left: 570px
- **Position**: Top: 70px
- **Size**: Height: 245px
- **Size**: Width: 250px
- **Unique Identifier**: vzPie
10. Run the webpage. The output should look similar to the following image.

11. Close the page to return to HTML Composer.

**Procedure: How to Create the Summary Sheet**

1. Insert another Visual Discovery control and click **Visual Discovery Summary Sheet**.
2. Click the **Empty Summary Sheet** component, and then select vzstoresales.txt from the Available Data Pool list.
3. Click **ActiveX Properties**, and then click the **Data** tab.
4. Click **Sales Rep** as the x-axis field. Click **Revenue** as the y-axis field.
5. Click the **Summary Sheet** tab. Click **Revenue** from the Sort By drop-down list and click **Reverse Sort By**.
6. Click the Titles tab and remove any titles from the summary sheet.

7. Click Apply, and then click OK.

8. Save your work.

9. Access the Properties pane on the right. From the drop-down list, click `activex5 <OBJECT>`, if not it is already selected.

   Specify the following values:

   - **Name**: `vzSummary`
   - **Position**: Left: 620px
   - **Position**: Top: 325px
   - **Size**: Height: 365px
   - **Size**: Width: 305px
   - **Unique Identifier**: `vzSummary`

10. Save your work.
11. Run the webpage. The final output should look similar to the following image.

![Chart Controls](image)

12. Close and save the page.

**Building an Application With Advanced Chart Controls**

This section of the tutorial illustrates how to build a sample chart control interface that allows the manipulation of information on the HTML page during run time. The chart controls are applied to the sample page, vzMySales.htm, using Visual Discovery controls and JavaScript API.

For more information on the JavaScript API, see *Using the Visual Discovery JavaScript API* on page 195.
Procedure: How to Create a Visual Discovery Control Panel Menu Bar

1. From the Insert menu, click Controls, then click Group Box.
2. Click and drag your cursor across the top of the canvas. A group box appears.
3. Delete the Group Box text by right-clicking the words Group Box and selecting Delete.
4. Access the Properties menu pane on the right. If needed, select Properties from the View menu.

Make sure that <FIELDSET> is the selected property in the Properties menu pane, then click the Styling: Advanced (CSS) ellipsis button.

5. From the options on the left, click Background, then click Silver from the color drop-down list in the Background color section.
6. From the options on the left, click Position. Specify the attributes as follows:
   - Top: 10px
   - Left: 15px
7. Click OK and save your work.

8. From the Insert menu, click Components, then click Line.

9. Click and drag your cursor within the group box to draw the line.

10. Access the Properties menu pane on the right. If needed, click Properties from the View menu.

   Make sure that line1 <SPAN> is the selected property in the Properties menu pane, then click the Styling: Advanced (CSS) ellipsis button.

11. From the options on the left, click Background, then select Gray from the color drop-down list in the Background color section.

12. From the options on the left, click Position. Specify the attributes as follows:

   - Top: 0px
   - Left: 240px
   - Height: 54px
   - Width: 2px

13. From the options on the left, click Edges. In the Borders section, specify the attributes as follows:

   - Style: Inset
   - Width: Thin

14. Click OK and save your work.

15. Create another line by repeating Steps 8 through 13 in this procedure. When you create the second line, note the following:

   - The selected property in the Properties menu pane should now be line2 <SPAN>.
   - The positioning will be as follows:

     - Top: 0px
     - Left: 690px
     - Height: 54px
16. When the second line is inserted, save your work and run the webpage.
17. Close the webpage and return to HTML Composer.

**Procedure: How to Create a Drop Down List Control for Selector Shapes**

This procedure adds a Drop Down List control to the menu bar, which can be used to set the way the mouse selects data graphically at run time. This applies to non-3D components only.

1. From the Insert menu, click Controls, then click *Drop Down List*.
2. Click and drag your cursor within the group box. The drop-down list appears.
3. Access the Properties menu pane on the right. If needed, select *Properties* from the View menu.

   Make sure that `combobox1 <SELECT>` is the selected property in the Properties menu pane. Set these attributes as follows:

   - Name: `cboSelection`
   - Position: Left: 5px
   - Position: Top: 25px
   - Size: Width: 100px
   - Styling: Font: *Arial 8pt*
   - Unique Identifier: `cboSelection`
4. Click the Parameters tab located in the lower-left corner of the HTML Composer window.

The Properties and settings dialog box appears.

**Note:** For the steps below, it is important that you make sure that `cboSelection <SELECT>` is the selected property in the Properties menu pane before you open the Parameters window. If it is not selected, you can select it from the drop-down menu at the top of the Properties menu. If it does not appear in the drop-down menu, you need to refresh the menu. You can do this by clicking anywhere on the active form, then back on the Properties menu pane.

5. Click Static from the Data Type radio button area.
6. Click the New button, and add the following options:

<table>
<thead>
<tr>
<th>Value</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Rectangle</td>
</tr>
<tr>
<td>1</td>
<td>Lasso</td>
</tr>
<tr>
<td>2</td>
<td>Circle</td>
</tr>
<tr>
<td>3</td>
<td>Rectangular brush</td>
</tr>
<tr>
<td>4</td>
<td>Circular brush</td>
</tr>
</tbody>
</table>

The following image shows the Properties and settings box with the newly added options.

7. Return to the Design view by clicking on the Design tab located in the lower-left corner of the HTML Composer window.

8. Click the Events tab located at the bottom of the Properties toolbox pane.

9. To add an event to the drop-down list whenever you select an option at run time, select the event onchange and click the ellipsis button.
10. Add the code below to the cboSelection_onchange function and then save your work.

```javascript
//VzSelectorShapeEnum
/*Shape         Value     Description
------------------------------------
VzSelRectangle    0       Rectangle
VzSelLasso        1       Lasso
VzSelCircle       2       Circle
VzSelRectBrush    3       Rectangular brush
VzSelCircleBrush  4       Circular brush
*/
var vzBarOne = document.getElementById('vzBarOne');
var varSelected = ctrl.options[ctrl.selectedIndex].value;
vzBarOne.SelectorShape = varSelected;
```

**Note:** The steps above added JavaScript code to the project. For more information on JavaScript standards and best practices, see *Using the Visual Discovery JavaScript API* on page 195.

11. Return to the design view by selecting the **Design** tab and return to the Properties menu pane by selecting the **Properties** tab at the bottom of the Properties toolbox pane.

12. From the Insert menu, click **Components**, then click **Text**.

13. Click and drag your cursor within the group box. The text appears.

14. Double-click inside the text object. Enter the text **Selector shape**.

15. Access the Properties menu pane on the right. If needed, click **Properties** from the View menu.

Make sure that **text1 <SPAN>** is the selected property in the Properties menu pane. Set these attributes as follows:

- Position: Left: 5px
- Position: Top: 8px
- Size: Height: 28px
- Size: Width: 100px
- Unique Identifier: txtSelector

16. Save your work, then run the webpage.
**Note:** The selector shape control allows you to choose portions of the Visual Discovery controls during run time, through use of different shape selection options. With the HTML page open, click *Circle*, in the Selector shape drop-down list. Click and drag your cursor across the pie chart. Notice the selection you choose is selected in a circular shape.

**Procedure:** How to Create a Drop Down List Control to Color By Fields

This procedure adds a Drop Down List control to the menu bar, which can be used to color any table in the data pool by the specified field at run time.

1. From the Insert menu, click *Controls*, then click *Drop Down List*.
2. Click and drag your cursor within the group box. The drop-down list appears.
3. Access the Properties menu pane on the right. If needed, click *Properties* from the View menu.

   Make sure that *combobox2 <SELECT>* is the selected property in the Properties menu pane. Set these attributes as follows:

   - Name: *cboColorBy*
   - Position: Left: 115px
   - Position: Top: 25px
   - Size: Width: 100px
   - Styling: Font: *Arial 8pt*
   - Unique Identifier: *cboColorBy*

   **Note:** For the steps below, it is important that you make sure that *cboColorBy <SELECT>* is the selected properly in the Properties menu pane before you open the Parameters window. If it is not selected, you can select it from the drop-down menu at the top of the Properties menu. If it does not appear in the drop-down menu, you need to refresh the menu. You can do this by clicking anywhere on the active form, then back on the Properties menu pane.

4. Click the *Parameters tab* located in the lower-left corner of the HTML Composer window.

   **Note:** The Properties and settings dialog appears, if not, select View in the HTML Composer menu bar, and then click *Properties and settings*.

5. Click Static from the Data Type radio button area.
6. Click the *Values are VisDis Color By* check box at the bottom of the dialog box.

7. Click the *New* button chart control drop-down list, select *Visual Discovery ActiveX*, and choose the following options from the cascading menus:
   - Select `vzBarOne`, then *Store Name*.
   - Select `vzBarTwo`, then *Region*.
   - Select `vzPie`, then *Product Type*.

   The following image shows the cascading menu options of the Properties and settings dialog box.

8. Return to the Design view by clicking on the *Design* tab located in the lower-left corner of the HTML Composer window.

9. On the Insert menu, click *Components*, then click *Text*.

10. Click and drag your cursor within the group box. The text appears.
11. Double-click inside the text object. Enter the text *Color by Field*.

12. Access the Properties menu pane on the right. If needed, click *Properties* on the View menu.

   Make sure that text2 <SPAN> is the selected property in the Properties menu pane. Set these attributes as follows:
   - Position: Left: 115px
   - Position: Top: 8px
   - Size: Height: 28px
   - Size: Width: 100px
   - Unique Identifier: txtColorBy

13. Save your work, then run the webpage.

**Note:** The Color by Field control allows you to select a field in run time, and color the Visual Discovery controls on the page based on the field you choose. With the HTML page open, click Region, in the Color by Field drop-down list. Notice Visual Discovery controls on the page change color according to the region data. The same can be repeated for Store Name and Product Type.

**Procedure:** How to Create a Push Button Control That Hides Excluded Items

This procedure adds a Push Button control to the menu bar that omits unselected items from the current display.

**Note:** This method is different from excluding. When you hide unselected items, the data is still present in other views. It would not be if excluded.

1. From the Insert menu, click *Controls*, then click *Push Button*.
2. Click and drag your cursor within the group box. The push button appears.
3. Access the Properties menu pane on the right. If needed, select *Properties* from the View menu.

   Make sure that button1 <INPUT> is the selected property in the Properties menu pane. Set these attributes as follows:
   - Name: btnHide
   - Position: Left: 705px
4. Right-click Hide Unselected and click Create Hyperlink.

5. In the Hyperlink properties dialog box, click the New button.

6. Click Visual Discovery Exclude from the Action drop-down list, then the vzstoresales data pool from the Source drop-down list.

The following image shows Visual Discovery Exclude and vzstoresales selected in the Hyperlink Properties dialog box.

7. Save your work, then run the webpage.
**Procedure:** How to Create a Push Button Control That Toggles Actively Selected Items

This procedure adds a Push Button control to the menu bar that toggles the actively selected items. Selected items become unselected, and the unselected items become selected.

1. From the Insert menu, select Controls, then click Push Button.
2. Click and drag your cursor within the group box. The push button appears.
3. Access the Properties menu pane on the right. If needed, click Properties from the View menu.

   Make sure that button2 <INPUT> is the selected property in the Properties menu pane. Set these attributes as follows:

   - Name: btnToggle
   - Position: Left: 835px
   - Position: Top: 20px
   - Size: 15px
   - Size: Height: 25px
   - Size: Width: 75px
   - Styling: Font: Arial 8pt Bold
   - Unique Identifier: btnToggle
   - Value: Toggle

4. Click the Events tab located at the bottom of the Properties toolbox pane.
5. To add an event to the button whenever it is clicked, select the event onclick and click the ellipsis button.
6. Add the code below to the btnToggle_onclick function and then save your work.

   ```
   vzBarOne.Command(7117, "", 0, 0); //***Toggle Unselected
   ```
7. Return to the design view by selecting the Design tab and return to the Properties menu pane by selecting the Properties tab at the bottom of the Properties toolbox pane.

8. Save your work, then run the webpage.

**Note:** The Toggle button allows you to switch views between selected data of a Visual Discovery control and the unselected data. With the HTML page open, click Video in the pie chart. Click Toggle and notice that the unselected data in the controls are selected. Click Toggle again then notice that the Video data is selected.

**Procedure:** How to Create a Push Button Control to Refresh Components

This procedure adds a Push Button control to the menu bar that刷新s all components on the page to their original state.

1. From the Insert menu, click Controls, then click Push Button.
2. Click and drag your cursor within the group box. The push button appears.
3. Access the Properties menu pane on the right. If needed, click Properties from the View menu.

Make sure that button3 <INPUT> is the selected property in the Properties menu pane. Set these attributes as follows:

- **Name:** btnReset
- **Position:** Left: 920px
- **Position:** Top: 20px
- **Size:** 44px
- **Size:** Height: 25px
- **Size:** Width: 75px
- **Styling:** Font: Arial 8pt Bold
- **Unique Identifier:** btnReset
- **Value:** Reset
4. Click the Events tab located at the bottom of the Properties toolbox pane.

5. To add an event to the button whenever it is clicked, select the event `onclick` and click the ellipsis button.

6. Add the code below to the `btnReset_onclick` function and then save your work.

   ```javascript
   vzBarOne.Command(7112, "", 0, 0); //***Restore Excluded
   vzBarOne.Command(7115, "", 0, 0); //***Select All
   ```

**Note:** The steps above added JavaScript code to the project. For more information on JavaScript standards and best practices, see *Using the Visual Discovery JavaScript API* on page 195.

7. Return to the design view by selecting the Design tab and return to the Properties menu pane by selecting the Properties tab at the bottom of the Properties toolbox pane.

8. Save your work, then run the webpage. The HTML Page should look similar to the following image.
**Procedure: How to Create Radio and Push Button Controls to Collect Data and Pass to a Report**

This procedure adds a Radio Button control and a Push Button control to the menu bar. Each control generates a list of strings representing the labels displayed for the selected items. One displays an active report, and the other displays a PDF.

1. From the Insert menu, click Components, then click Text.
2. Click and drag your cursor within the group box. The text appears.
3. Double-click inside the text object. Enter the text *Make selections in the Bar and/or Pie charts*.
4. Access the Properties menu pane on the right. If needed, click Properties from the View menu.

   Make sure that `text3 <SPAN>` is the selected property in the Properties menu pane. Set these attributes as follows:

   - Position: Left: 255px
   - Position: Top: 10px
   - Size: Height: 35px
   - Size: Width: 194px
   - Unique Identifier: `txtCollect`

5. From the Insert menu click New Report, and drag your cursor across a blank area of the dashboard to draw a report container.
6. Right-click the report container, and click Reference existing procedure. The Get source file dialog box opens.
7. Click the `VZDashboard.fex` file and click Open.

   **Note:** If you did not add the ibidemo folder directory when you first created your new project in HTML Composer, you must copy the file into your application folder. `VZDashboard.fex` can be copied from `\ibi\apps\ibidemo`.

8. In the New Parameters dialog box, click the ellipsis buttons under Control Type as follows:
PRODUCTTYPE. Select *Existing control*, then vzPie.

STORENAME. Select *Existing control*, then vzBarOne.

REGION. Select *Existing control*, then vzBarTwo.

9. Select *Do not create a form* from the Parameter grouping options section.
   The following image shows the New Parameters dialog box.

![New Parameters dialog box](image)

10. Click OK. A panel with the PDF icon and radio button appear on your dashboard.

11. From the Properties pane drop-down list, select *radio1 <SPAN>.*
   The chart control Properties and Settings dialog box opens.

12. From the Properties and settings dialog box, click the New button to add a new control.
   Value2 appears below the PDF value.

13. Edit Value2 as follows:
   - Name Value2, AHTML, under Value and Display.
   - Click the ellipsis button under Display. Select *format_ahtml_32.png* and click Open.
   An AHTML report icon and radio button appear next to the PDF icon and radio button.

   **Note:** *format_ahtml_32.png*, should be copied from the \\ibi\\DevStudio81\\ibi_html\\javaassist\\ibi\\html\\describe folder to your application folder.
14. Click the Parameters tab, at the bottom left of your screen.
   You must map the parameter names to the data pool fields properly to run the report selections properly.

15. Click the arrowhead under vzBarOne.
   A Properties and settings dialog box appears.

16. Click Store Name from the Use Value From drop-down list.

17. Repeat for vzBarTwo, and vzPie. Select:
   Region under vzBarTwo. Product Type under vzPie.

18. Select radio1 <SPAN> in the Properties pane, hold down the ALT key and drag the radio buttons up to the group box, next to the Make selections in the Bar and/or Pie Charts text.

19. Make sure that <radio1 <SPAN> is the selected property in the Properties menu pane. Set the attributes as follows:
   - Position: Left: 405px
   - Position: Top: 0px
   - Size: Height: 55px
   - Width: 205px

20. Select button4 <INPUT>, hold down the ALT key and drag the button up to the group box, next to the radio button selections.

21. Right-click button4 <INPUT>, and click Hyperlink properties.
   The Hyperlink Properties dialog box opens.

22. In the Hyperlink Properties dialog box, make the following changes:
   - Delete text from the Display Text field.
   - Select Window from the Target Type drop-down list.
   - Select New Window from the Target/Template Name drop-down list.
The following image shows the Hyperlink Properties dialog box.

23. Make sure that `button4` is the selected property in the Properties menu pane. Set these attributes as follows:

- **Name:** `btnRun`
- **Position:** Left: 626px
- **Position:** Top: 20px
- **Size:** 20px
- **Size:** Height: 22px
- **Size:** Width: 38px
- **Unique Identifier:** `btnRun`

24. From the Properties pane drop-down list, select `panel1` and press Delete on your keyboard. Repeat for `report1`.
25. Save your work, then run the webpage. The final output should look similar to the following image.

![WebFOCUS](image)

26. Make selections in the bar and pie charts, then select the desired output format, **PDF** or **AHTML**, and click the **Run** button.

The values from the charts are passed to the report. The report contains the selected data only.

**Note:** To accurately reflect the parameter values selected from the three charts, you must update the WHERE statements in the Vzdashboard.fex to use multi-select syntax.

To update the Vzdashboard.fex:

1. Make a backup copy of the Vzdashboard.fex file.
2. Comment out the following lines:

```plaintext
WHERE (PRODUCTTYPE EQ '&PRODUCTTYPE');
WHERE (STORENAME EQ '&STORENAME');
WHERE (REGION EQ '&REGION');
```

---

104 WebFOCUS
3. Add the following multi-select WHERE statements:

```sql
WHERE PRODUCTTYPE EQ &PRODUCTTYPE.(OR(FIND PRODUCTTYPE IN CENTURYSALES));
WHERE STORENAME EQ &STORENAME.(OR(FIND STORENAME IN CENTURYSALES));
WHERE REGION EQ &REGION.(OR(FIND REGION IN CENTURYSALES));
```

4. Save the updated Vzdashboard.fex file.

5. Run the webpage. Now, when you make selections in the bar and pie charts, multiple parameters can be passed to the report.
Deploying Visual Discovery Applications

This topic describes how to deploy WebFOCUS Visual Discovery applications.

For details on the thick-client deployment, see VZ Web Server (Thick Client) Deployment on page 19.

In this chapter:

- Deploying WebFOCUS Visual Discovery Applications for VZ Web Server (Thick Client)

Deploying WebFOCUS Visual Discovery Applications for VZ Web Server (Thick Client)

WebFOCUS Visual Discovery applications can be deployed over the web using the digitally signed Vz.cab file and the VzLicense.lpk file included on the WebFOCUS Visual Discovery VZ Web Server installation CD. The cabinet (Vz.cab) file installs the component files to the drive:\Program Files\Common Files\ADVIZOR Components directory. The license package (VzLicense.lpk) file allows the use of licensed ActiveX controls in an HTML page on a non-licensed computer.
Note:

- If you are using the WF Servlet, copy the VzLicense.lpk file to the root of the web application.
- You need to modify the HTML page with the appropriate version information as new cab files are made available. For example, the version information for Developer Studio 8 is 9.0.2011.509, so the proper syntax is:

  ```html
  <object classid="clsid:601CD7CF-7278-11D1-871D-00A02411D404"
  width="100%" height="100%" codebase="http://server/path/Vz.cab#version=9.0.2011.509" >...</object>
  ```

To verify the current version number, you can look at the file version string on the Version tab of the file properties dialog box for DLLs like VzLib.dll.

- Thick-client deployment is platform independent and is the same on all platforms. For example, the deployment procedures in this section are procurable when using a UNIX platform.

- In the procedures and examples that follow for thick-client deployment in Managed Reporting and WebFOCUS Client, the command VIEWASTEXT indicates that the Visual Discovery component is no longer available for editing. Therefore, HTML Composer will not display the component on the canvas.

Procedure: How to Configure Visual Discovery Pages for Thick Client Deployment in Managed Reporting

Tip: During Managed Reporting remote development, users other than the developer may access the Visual Discovery webpage. Therefore, when you are developing webpages in Managed Reporting, you can follow these steps, but omit the command VIEWASTEXT. HTML Composer will display the component on the development canvas.

1. Copy the Vz.cab file, the data file you create using the FORMAT VISDIS command, or the FOXEXEC with the PCHOLD FORMAT VISDIS command, and the VzLicense.lpk file to the web server that hosts each domain within Managed Reporting. You can find the Vz.cab and VzLicense.lpk files in the zip file. Place the files in the following directory:

   ```
   \ibi\WebFOCUS81\ibi_html\visdis
   ```

   If the visdis directory does not exist, then you must create it manually.

Note: If using a UNIX platform, FTP the Vz.cab file and VzLicense.lpk file to the UNIX machine in BINARY format.
2. Insert the following HTML code in each Visual Discovery webpage:

   a. Place the following code within the <BODY> tags prior to all other <OBJECT> tags:

   ```html
   <OBJECT CLASSID = "clsid:5220cb21-c88d-11cf-b347-00aa00a28331"
   id=licensemgrobj VIEWASTEXT>
   <PARAM NAME="LPKPath"
   VALUE="/ibi_html/visdis/VzLicense.lpk"></OBJECT>
   ```

   b. Place the following code into each <OBJECT> tag corresponding to its Visual Discovery component. Insert this code following the classid attribute.

   ```html
   codebase="http://server/ibi_html/visdis/
   Vz.cab#version=9.0.2011.509" VIEWASTEXT
   ```
   where:
   ```html
   server
   ```
   is the server that hosts each domain within Managed Reporting.

**Procedure: How to Configure Visual Discovery Pages for Thick-Client Deployment in the WebFOCUS Client**

1. Copy the Vz.cab file, the data file you create using the FORMAT VISDIS command, or the FOXEXEC with the PCHOLD FORMAT VISDIS command, and VzLicense.lpk file to the web server that hosts the Visual Discovery webpage. Place the files at the root of the virtual directory of the application. You can find the Vz.cab and VzLicense.lpk files in the zip file.

**Note:** If using a UNIX platform, FTP the Vz.cab file and VzLicense.lpk file to the UNIX machine in BINARY format.
2. Insert the following HTML code for each Visual Discovery webpage:
   
   **a.** Place the following code within the <BODY> tags prior to all other <OBJECT> tags:
   
   ```html
   <OBJECT CLASSID = "clsid:5220cb21-c88d-11cf-b347-00aa00a28331"
   id=licensemgrobj VIEWASTEXT>
   <PARAM NAME="LPKPath" VALUE="/ibi_html/visdis/VzLicense.lpk">
   </OBJECT>
   ```
   
   **b.** Place the following code into each <OBJECT> tag corresponding to its Visual Discovery component. Insert this code following the classid attribute.
   
   ```html
   ```
   
   where:
   
   - **server**
     Is the server that hosts the Visual Discovery pages.
   
   - **appname**
     Is the name of the application that contains the Visual Discovery pages.

3. Execute the thick-client webpage by entering the following information in your browser
   
   ```text
   http://server/approot/appname/htmpagename.htm
   ```
   
   where:
   
   - **server**
     Is the name of the web server hosting the thick-client webpage.
   
   - **appname**
     Is the name of the application that contains the thick-client webpage and the related application files.
   
   - **htmpagename**
     Is the name of the thick-client HTM file.

**Procedure:** How to Use the Scenario Wizard to Deploy Visual Discovery Application Files (Thick-Client)

If you are developing in the Projects area of Developer Studio, you have the option of using the Deploy Scenario Wizard to move your application files to your WebFOCUS run-time environment. The Deploy Scenario Wizard automatically edits the paths to the .txt files and .fex files in the HTML file, as well as updating the CAB version.
1. Go to the Developer Studio Explorer window and select the application project. In order to deploy the thick-client files, your project needs to be able to see them. To do this, you must add the TXT extensions to your project. Add additional file extensions, such as JS for resource files, if they are also being used in your project.

To add these file extensions to your project:
   a. Right-click the application project and click Properties.
   b. Click the Edit Filters tab.
   c. Click the Add new file type filter(s) button. The New Filter dialog box opens.
   d. Scroll to the txt document extension, select it, and click OK.
   e. Repeat to add additional file types.
   f. Click OK to close the Properties dialog box.

2. Click the Binoculars button to display all files in your project path. Find the XML file and the HTM files for your project.

3. Select and then right-click both files, and click Add to Project on the menu.

4. From the deploy drop-down list, click New Deploy Scenario.

   The New Scenario Wizard opens. For complete details on how to use the New Scenario Wizard, see the Creating Reporting Applications With Developer Studio manual or click Help from the wizard to view the online documentation.

   You may specify the HTM file as your starting object, or simply deploy the files and open a browser window to execute your webpage.

5. Run the Deploy Scenario.

   If you chose to deploy and run, with a starting object specified, it will run when the files have finished deploying.

6. Execute the webpage by entering the following in your browser:

   http://server:port/approot/appname/htmpagename.htm

   where:

   server
   Is the name of the web server hosting the thick-client page.

   appname
   Is the application name to which you deployed the thick-client page and related application files.
htmpagename

Is the name of the thick-client HTM file.
Tables, charts, and graphs communicate information in an illustrative way and help make complex business data easy to read and understand. In order for these images to be as intuitive as possible, the information they contain must be displayed in the most appropriate format. The correct graphical representation of business data, whether they are pie charts, scatter plots, or histograms, can give new meaning to the information users view and can provide instantaneous answers to the most urgent business questions.

The topics in the chapter provide the business use for each visualization component and show you how to edit the component properties. For details on how to insert a visualization component into your dashboard, see *Developing an Analytic Dashboard* on page 23.

**In this chapter:**

- What Is a Glyph?
- Bar Charts
- Line Charts
- Pie Charts
- Histograms
- Counts
- Data Constellations
- Data Constellation Maps
- Data Sheets
- Multiscapes
- Paraboxes
- Scatter Plots
- Summary Sheets
- Time Tables
- Perspectives
What Is a Glyph?

A glyph is a graphic (such as an icon) used to represent data. When you look at the different types of visualization components, for example, the bar chart or the parabox, you will see many glyphs that represent the selected data.

The following image points to some of the glyphs in the graph. All of the objects that represent data are glyphs.

Bar Charts

A bar chart or bar graph is a diagram that provides a means of quantitative comparison by displaying rectangular bars of differing heights or lengths that are proportional to the statistics or data they represent. Bar charts display the distribution of a single, discrete or dependent variable across an independent variable. This means that a bar chart plots the distribution of numerical data against a scale. The length of a bar chart corresponds to a value or amount, and can be arranged either horizontally or vertically. These are also known as column charts or graphs. Bar charts are most frequently used to analyze changes within a data group or category or to demonstrate dissimilarities between items.

Viewers can develop a clear mental image of comparisons among data series by distinguishing the relative heights of the bars. You can also use a spine plot in a bar chart, where the values correspond to the width of the bar, rather than the height.
The following image shows an example of a bar chart diagram.

With WebFOCUS Visual Discovery, you can measure and compare information by creating comprehensive, easily understandable bar charts. These bar charts can support thousands of bars and can include robust features, such as:

- **Stacked colors.** Simultaneously displays multiple attributes in a single bar or column.
- **Sorting.** Quickly detects patterns and find results.
- **Zooming.** Selects and views appropriate subsets of data.
- **Spine-plot variation.** Distinguishes proportions across groups by simply adjusting bar thickness based on the data.
- **Goal lines.** Accurately measures actual versus planned results.
- **Weighting.** Displays data values in accordance to bias.
- **Animation control.**
- **Net aggregation.** See *Aggregating Data in Pie and Bar Charts* on page 128.

**Procedure:** How to Change the Orientation of a Bar Chart

1. In the Visual Discovery Properties dialog box, click the *Bar Chart* tab.
2. In the Style field, click the *Horizontal* button [ ] or the *Vertical* button [ ].
3. Click *Apply*, and then click *OK*.

**Tip:** In the pop-up menu, if Horizontal has a check next to it then the graph has a horizontal orientation. Click *Horizontal* to remove the check and change the orientation to vertical.
Using a Spine Plot in a Bar Chart

You can display data in a bar chart either with the standard bar chart display, where data is mapped to the length of the bar, or as a spine plot. The spine plot presentation normalizes the regular bar chart data, then uses the bar width to represent the number of cases and the comparative percentages of items in each case.

The spine plot is useful when you want to compare the percentage of a category that is selected with other categories.

Note:
- Goal lines are not supported with spine plot.
- Spine plot is not a valid option until data has been loaded into the visualization component.

Procedure: How to Change the Style of a Bar Chart to a Spine Plot

1. In the Visual Discovery Properties dialog box, click the Bar Chart tab.
2. In the Style field, click the Spine plot button (all bars are of equal height).
3. Click Apply, and then click OK.

Tip: From the pop-up menu, select Spineplot.

Reference: Spine Plots in Bar Charts

The following images represent the same data. This graph has the standard bar style, where the data is mapped to the length of the bar.
This graph has the spine plot style, where the data is mapped to the width of the bar.

Using Clusters in a Bar Chart

A cluster bar chart is a bar chart with multiple y-axis data fields. Instead of weighting the bar chart using one y-axis selection, you can use two or more data fields for the y-axis, creating groups of bars for each x-axis value.

**Procedure: How to Create a Cluster Bar Chart**

1. In the Visual Discovery Properties dialog box, click the **Data** tab.
2. Select one x-axis field and two or more y-axis fields (the y-axis fields must be numeric).
3. Click **Apply**. The graph displays grouped bars for each x-axis value.
4. Click the **Bar Chart** tab.
5. To color the graph by:
   - A field, select **None (Use Table)** from the Clusters field. The graph will be colored by the field selected in the Colors tab.
   - The fields graphed along the Y axis, select a color scale from the Clusters field. The labels along the Y axis are color-coded with the bars they represent.
6. Click **Apply**, and then click **OK**.
**Reference:** **Bar Chart Tab**

The following image shows the Bar Chart tab in the Visual Discovery Properties dialog box.

**Style**

**Orientation**

Is vertical or horizontal. See *How to Change the Orientation of a Bar Chart* on page 115.

**Spine Plot**

Changes the style of the bar chart to a spine plot. See *Using a Spine Plot in a Bar Chart* on page 116.

**Color**

**Stack Colors**

Colors bars according to data in a third field. See *Assigning Color to the Data and the Graph* on page 31.

**Clusters**

Creates a bar chart with multiple y-axis fields. See *Using Clusters in a Bar Chart* on page 117.

**Labels Shown**

Sets the label mode. See *Displaying Labels* on page 47.

**Order**

Controls the sequence in which glyphs are presented. See *Selecting Primary and Secondary Order* on page 46.
Show Unselected

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and choose Select All.

Allow Zoom

Enables the zoom bar. The zoom bar lets you zoom in on the details of data or zoom out to look at the big picture.

Animate

Select this option to put a single component or a perspective into a mode where its glyphs are automatically colored and not colored in sequential order. See Animating Data on page 45.

Reference: Bar Chart Pop-up Menu

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear in a bar chart when you are developing in HTML Composer.

Horizontal

Is the orientation of the graph. If Horizontal is checked, the orientation of the graph is horizontal. If it is not checked, the orientation is vertical.

Spine Plot

Spine plot is a bar chart where width, rather than height, represents the value of the data. See Using a Spine Plot in a Bar Chart on page 116.

Net Mode

Shows aggregated data. See Aggregating Data in Pie and Bar Charts on page 128.

Show Unselected

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and choose Select All.

Show Goal Lines

Shows goal lines on the graph. See Using Goal Lines on page 44.
**Animate**

Select this option to put a single component or a perspective into a mode where its glyphs are automatically colored and not colored in sequential order. See *Animating Data* on page 45.

**Primary Order**

Displays the items in one of the following orders: Original Order, Label, Size, Total Selected, or Percent Selected. See *Selecting Primary and Secondary Order* on page 46.

**Label Mode**

Sets the label mode. See *Displaying Labels* on page 47.

**Label ’name’**

Adds or removes the label from the selected data item.

**Create Goal Line**

Places a goal line on the graph. See *Using Goal Lines* on page 44.

**Full Size**

Shows text in a normal, readable size.

**Fit All**

Shows the entire table in the current window. If there are fewer table rows than will fit in the window at full size, then the lines are shown in a larger font with more spacing. If there are more lines than will fit, then they are reduced to a smaller size, with a minimum of 1 pixel high. If all table rows does not fit at 1 pixel high, then lines are overplotted to allow all to fit. When values are overplotted, the line that is the longest or with the hottest color is drawn on the top, obscuring all others under it.

**One Line/Pixel**

Draws text as one-pixel-high lines. This is helpful when you need to reduce the size of the text to see more of the data. Depending on how many lines you have in your table, this may still require paging to see all rows.

**Undo**

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.
Redo
Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

Select All
Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

Unselect All
When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hidden, unselected is active).

Toggle All
Reverses the selection state of items. Selected items become unselected and unselected items become selected.

Exclude Unselected
Excludes (temporarily removes) items from the graph.

Restore Excluded
Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

Save Image
Enables you to save the graph to a GIF or JPEG file.

Copy Image
Enables you to copy the selected component and paste it to another file.

Properties
Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.
Line Charts

A line chart or line graph is a diagram that compares the relationship between two variables, one dependent and one independent. It demonstrates the effect of the independent variable on the dependent variable by showing successive points, each representing a different data value, connected by straight lines. Line charts show aggregated values rather than individual values. More than one data point must be present in order to create a line chart. These charts are particularly useful in examining a sequence of values to determine growth trends, displaying data that changes continuously over time and helping to identify patterns that make predictions about the results of data not yet recorded.

Line charts can be in one of two forms: a more traditional chart, which uses multiple y-axis fields and results in multiple plotted lines, or a single y-axis line chart, in which the default view is a series of bars connected by lines.

The following image shows an example of a multiple line chart diagram.

WebFOCUS Visual Discovery enables you to rapidly create a variety of line charts, including filled line charts, as well as multiple line charts that are directly stacked or stacked in separate panels. Additionally, you can display multiple lines within the same line chart and scroll or zoom for convenient navigation of long lines.

Other capabilities include:

- **Stacked colors.** Simultaneously displays multiple attributes in a single line.
- **Clusters.** Groups related lines together on the diagram.
- **Weighting.** Assesses data values on a curve.
- **Animation control.**
**Procedure:** How to Change the Orientation of a Line Chart

1. In the Visual Discovery Properties dialog box, click the *Line Chart* tab.
2. In the Style field, click the *Horizontal* button or the *Vertical* button.
3. Click *Apply*, and then *OK*.

**Tip:** In the pop-up menu, if Horizontal has a check mark next to it, then the graph has a horizontal orientation. Click *Horizontal* to remove the check mark and change the orientation to vertical.

**Reference:** Line Chart Tab

The following image shows the Line Chart tab in the Visual Discovery Properties dialog box.

<table>
<thead>
<tr>
<th>Data</th>
<th>Line Chart</th>
<th>Colors</th>
<th>Selecting</th>
<th>Fonts</th>
<th>Titles</th>
<th>BookMarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>Orientation: <img src="image" alt="Horizontal" /> <img src="image" alt="Vertical" /></td>
<td>Order</td>
<td>Primary: <img src="image" alt="Label" /> Secondary: <img src="image" alt="Label" /></td>
<td>Fill Between Areas</td>
<td>Show Unselected</td>
<td>Allow Zoom</td>
</tr>
<tr>
<td>Bar Size</td>
<td><img src="image" alt="Stack Colors" /> Clusters: <img src="image" alt="Dropdown" /></td>
<td>Animation</td>
<td><img src="image" alt="Animate" /> <img src="image" alt="Slower" /> <img src="image" alt="Normal" /> <img src="image" alt="Faster" /></td>
<td>Color</td>
<td><img src="image" alt="Dropdown" /></td>
<td>Labels Shown: <img src="image" alt="Best Fit" /></td>
</tr>
</tbody>
</table>

**Style**

Orientation is horizontal or vertical.

**Fill Between Areas**

Colors the space between the connecting lines. In essence, this creates an area graph.

**Bar Size**

Adjusts the bar size from narrow (slide the bar towards the left) to wide (slide the bar towards the right).
Line Charts

Color

Stack Colors
A glyph may be colored to show two fields that have been colored by a third field. See Assigning Color to the Data and the Graph on page 31.

Clusters
Creates a line chart with multiple y-axis fields.

Labels Shown
Sets the label mode. See Displaying Labels on page 47.

Order
Controls the sequence in which glyphs are presented. See Selecting Primary and Secondary Order on page 46.

Show Unselected
Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and choose Select All.

Allow Zoom
Enables the zoom bar. The zoom bar lets you zoom in on the details of data or zoom out to look at the big picture.

Animate
Select this option to put a single component or a perspective into a mode where its glyphs are automatically colored and not colored in sequential order. See Animating Data on page 45.

Reference: Line Chart Pop-up Menu

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

Horizontal
Is the orientation of the graph. If Horizontal is checked, the orientation of the graph is horizontal. If it is not checked, the orientation is vertical.
Show unselected

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and choose Select All.

Show Goal Lines

Shows goal lines on the graph. See Using Goal Lines on page 44.

Animate

Select this option to put a single component or a perspective into a mode where its glyphs are automatically colored and not colored in sequential order. See Animating Data on page 45.

Primary Order

Displays the items in one of the following orders: Original Order, Label, Size, Total Selected, or Percent Selected. See Selecting Primary and Secondary Order on page 46.

Label Mode

Sets the label mode. See Displaying Labels on page 47.

Label ‘name’

Adds or removes the label from the selected data item.

Create Goal Line

Places a goal line on the graph. See Using Goal Lines on page 44.

Full Size

Shows text in a normal, readable size.

Fit All

Shows the entire table in the current window. If there are fewer table rows than will fit in the window at full size, then the lines are shown in a larger font with more spacing. If there are more lines than will fit, then they are reduced to a smaller size, with a minimum of 1 pixel high. If all table rows does not fit at 1 pixel high, then lines are overplotted to allow all to fit. When values are overplotted, the line that is the longest or with the hottest color is drawn on the top, obscuring all others under it.
One Line/ Pixel

Draws text as one-pixel-high lines. This is helpful when you need to reduce the size of the text to see more of the data. Depending on how many lines you have in your table, this may still require paging to see all rows.

Undo

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

Redo

Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

Select All

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

Unselect All

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

Toggle All

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

Exclude Unselected

Excludes (temporarily removes) items from the graph.

Restore Excluded

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

Save Image

Enables you to save the graph to a GIF or JPEG file.

Copy Image

Enables you to copy the selected component and paste it to another file.
Properties

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.

Pie Charts

Pie charts, also known as pie graphs, circular charts, or circular graphs, divide complete data sets into slices, with each slice representing a group or subset of that data. The size of the slice corresponds with the percentage of the whole that particular group makes up. Pie charts are best for understanding data in terms of proportions and showing how sizes of parts relate to a whole.

The following image shows an example of a pie chart.

![Pie Chart Example](image)

Revenues per Quarter

WebFOCUS Visual Discovery enables you to create powerful pie charts or view groups of pie charts to compare a number of categories at once. You can also customize the view of the pie chart through flexible color-coding, rotation, exploding, and ordering. Additional features include:

- **Stacked colors.** Simultaneously displays multiple attributes in a single slice.
- **Weighting.** Assesses data values on a bias.

Keep in mind that pie graphs work best when your data consists of several large sets. Too many variables divide the pie into small segments that are difficult to see. Use color or texture on individual segments to create visual contrast.

The values in the y-field (weighting) should be greater than zero, since zeros and negative values are ignored in the calculation of the wedge size.
Rotating Data

You can change the positioning of the wedges in a pie chart by using the rotation option. This controls the position of the first ordered wedge. You may want to rotate the pie chart so that the most important wedge is at a more visible position (such as the 12 o'clock position).

Procedure: How to Rotate Data

1. In the Visual Discovery Properties dialog box, click the Pie Chart tab.
2. In the Rotation field, select the appropriate degree of rotation.
   
   Options (by degrees) are: 0, 45, 90, 130, 180, 225, 270, 315. At 0 rotation, the first wedge begins at the top position (12 o'clock), and at 180 rotation, the first wedge begins at the bottom position (6 o'clock). The default is 0.

3. Click Apply, and then click OK.

   Tip: From the pop-up menu, click Rotation and then select the appropriate value.

Exploding Data

The explode option increases the space between each wedge, pulling apart each wedge of the pie from the center. The available options are None, Small, Medium, and Large. The default is None.

The explode option applies to two-dimensional components.

Procedure: How to Explode Data

1. In the Visual Discovery Properties dialog box, click the Pie Chart tab.
2. In the Explode field, select the desired option.
3. Click Apply, and then click OK.

   Tip: From the pop-up menu, click Explode, and then select the desired option.

Aggregating Data in Pie and Bar Charts

In pie and bar charts, you can choose to show net aggregation. Net aggregation generates the sum of all positive and negative values in a data set, and the Visual Discovery control displays the net sum, rather than the weighted sum.

Also in a pie chart, you can show only data with positive values or only data with negative values.
**Example:**  Net Aggregation in a Pie Chart

The following image shows a pie chart that displays the profit from three countries.

![Pie Chart Example](image)

In this example, Canada has a loss that is indicated by the slice texture, the line along the edge of the slice, and the parentheses around the country name. With this net sum representation of the data, there is no loss of information. If a weighted mode were used, Canada would be omitted from this chart.

**Procedure:**  How to Toggle Net Aggregation Modes in a Pie Chart

Right-click the pie chart and click *Weighting Mode*, then select one of the following:

- *Include All.* This shows all data, negative and positive.
- *Positives Only.* This shows only positive data.
- *Contributors Only.* This only shows negative data.

**Procedure:**  How to Toggle Net Aggregation Modes in a Bar Chart

Right-click a bar chart and click *Net Mode*. 

**Reference:** Pie Chart Tab

The following image shows the Pie Chart tab in the Visual Discovery Properties dialog box.

![Pie Chart Tab](image)

**Show Unselected**

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and choose Select All.

**Stack Colors**

A glyph may be colored to show two fields that have been colored by a third field. See Assigning Color to the Data and the Graph on page 31.

**3D**

Displays the slices of a pie chart in three dimensions.

**Rotation**

Rotates the placement of slices in a pie graph. See Rotating Data on page 128.

**Explode**

Explodes slices so they stand out. See Exploding Data on page 128.

**Labels Shown**

Sets the label mode. See Displaying Labels on page 47.

**Order**

Controls the sequence in which glyphs are presented. See Selecting Primary and Secondary Order on page 46.
**Animate**

Puts a single component or a perspective into a mode where its glyphs are automatically colored and not colored in sequential order. See *Animating Data* on page 45.

**Reference:**  **Pie Chart Pop-up Menu**

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

**Show Unselected**

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and choose *Select All*.

**Rotation**

Rotates the placement of slices 0, 45, 90, 135, 180, 225, 270, or 315 degrees.

**Explode**

Moves the slices apart so that they stand out more dramatically. Available options are None, Small, Medium, and Large.

**Weighting Mode**

Select from Include All, Positives Only, or Contributors Only. See *Aggregating Data in Pie and Bar Charts* on page 128.

**Animate**

Puts a single component or a perspective into a mode where its glyphs are automatically colored and not colored in sequential order. See *Animating Data* on page 45.

**Primary Order**

Displays the items in one of the following orders: Original Order, Label, Size, Total Selected, or Percent Selected. See *Selecting Primary and Secondary Order* on page 46.

**Label Mode**

Sets the label mode. See *Displaying Labels* on page 47.

**Label 'name'**

Adds or removes the label from the selected data item.
Undo

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

Redo

Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

Select All

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

Unselect All

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

Toggle All

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

Exclude Unselected

Excludes (temporarily removes) items from the graph.

Restore Excluded

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

Save Image

Enables you to save the graph to a GIF or JPEG file.

Copy Image

Enables you to copy the selected component and paste it to another file.

Properties

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.
Histograms

A histogram groups data values into classes and shows the frequency at which each class appears in the data set by displaying a series of columns whose width represents class intervals and whose areas are proportional to the corresponding frequencies. The shapes of histograms will vary depending on the choice of the size of the intervals. Histograms are designed for situations when the user is not interested in knowing the particular values, but in how those values are distributed across the data set.

The following image shows an example of a histogram.

![Histogram Example](image)

WebFOCUS Visual Discovery enables you to see and understand locations and variations within the data by creating easy-to-read histograms with powerful features, such as:

- **Stacked colors.** Simultaneously represents multiple attributes of a single data class or group.
- **Smoothing.** Controls the way random variations in the data are displayed.
- **Orientation.** Displays the histogram either vertically or horizontally.
- **Weighting.** Displays class or group values in accordance to a bias.

**Procedure: How to Change the Orientation of a Histogram**

1. In the Visual Discovery Properties dialog box, click the **Histogram** tab.
2. In the **Style** field, click the **Horizontal** button or the **Vertical** button.
3. Click **Apply**, and then click **OK**.
**Tip:** In the pop-up menu, if Horizontal has a check mark next to it then the graph has a horizontal orientation. Click *Horizontal* to remove the check mark and change the orientation to vertical.

**Procedure: How to Select the Histogram Scale**

1. In the Visual Discovery Properties dialog box, click the *Histogram* tab.
2. In the x-axis scale field, select:
   - *Linear* as the default presentation.
   - *Root*, which is a factor of a number that, when multiplied by itself, gives the number. For example, the square root of 9 is 3. This is useful when looking at highly skewed distributions because it evenly reduces the positions of the items, making them appear closer together.
   - *Log*, which is the exponent that indicates the power to which a number is raised to produce a given number. For example, the logarithm of 100 to the base 10 is 2. When you have a large range of an item (like one item in a million), log is useful because it maintains the relative position of the item while reducing the extremes.
3. Click *OK* and then click *Apply*.

**Smoothing a Histogram**

Smoothing is a statistical technique in which data is averaged to remove extreme highs and lows. If little smoothing is applied, the data distribution reflects the exact data sample. Higher degrees of smoothing reduce the extreme highs and lows in the sample to show the idealized distribution of data.

**Procedure: How to Smooth a Histogram**

1. In the Visual Discovery Properties dialog box, click the *Histogram* tab.
2. In the Smoothing section, move the slider bar to the right or left to increase or decrease the amount of smoothing. The change in smoothing appears immediately.
**Reference: Histogram Tab**

The following image shows the Histogram tab in the Visual Discovery Properties dialog box.

![Histogram Tab Image](image)

**Style**

Orientation is horizontal or vertical. See *How to Change the Orientation of a Histogram* on page 133.

**X Axis Scale**

Is linear, root, or log. See *How to Select the Histogram Scale* on page 134.

**Stack Colors**

A glyph may be colored to show two fields that have been colored by a third field. The colors are stacked on a glyph. See *Assigning Color to the Data and the Graph* on page 31.

**Smoothing**

A statistical technique in which data is averaged to remove extreme highs and lows. See *Smoothing a Histogram* on page 134.

**Reference: Histogram Pop-up Menu**

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

**Horizontal**

Is the orientation of the graph. If Horizontal is checked, the orientation of the graph is horizontal. If it is not checked, the orientation is vertical.

**Stack Colors**

A glyph may be colored to show two fields that have been colored by a third field. The colors are stacked on a glyph. See *Assigning Color to the Data and the Graph* on page 31.
**Scale**

Changes the scale of the histogram to Linear, Root, or Log.

**Undo**

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

**Redo**

Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

**Select All**

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

**Unselect All**

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

**Toggle All**

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

**Exclude Unselected**

Excludes (temporarily removes) items from the graph.

**Restore Excluded**

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

**Save Image**

Enables you to save the graph to a GIF or JPEG file.

**Copy Image**

Enables you to copy the selected component and paste it to another file.

**Properties**

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.
Counts

A count provides a statistical summary of a data table and lists exact numerical values for data fields within the table in an easy-to-read, textual format. Counts should be used when specific information (for example, mean, standard deviation, minimum, maximum, or most common value) is needed for either an entire table or a selected subset of that table. They can include selected or deleted records, total records, and miscellaneous statistics.

The following image shows an example of a count.

Counts that are created using WebFOCUS Visual Discovery can display data in these formats:

- **Default.** Presents the most complete list of statistics.
- **Simple.** Presents a subset of the statistics presented in the default presentation. It presents the total number of items, the number of selected items, and mean, minimum, and maximum for the items.
- **Selected.** Presents statistics about the selected item(s). It provides statistics on the total number of selected items: the mean and standard deviation for the selected items, the minimum, maximum, sum, unique number of strings, and mode for selected items.

The counts component is typically used with other data visualization components.

**Note:** You can only see summary statistics in counts. You cannot select items in this component. The count items update as you select data in the other visualization components on a dashboard. When selections are made in other components however, counts are updated.
**Reference:** Formats for Counts

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>The total number of all items.</td>
</tr>
<tr>
<td>Deleted</td>
<td>The total number of excluded items.</td>
</tr>
<tr>
<td>Max</td>
<td>The largest value of any item.</td>
</tr>
<tr>
<td>Max Sel</td>
<td>The largest value of any of the selected items.</td>
</tr>
<tr>
<td>Mean</td>
<td>The mean of all items.</td>
</tr>
<tr>
<td>Mean Sel</td>
<td>The mean of the selected items.</td>
</tr>
<tr>
<td>Min</td>
<td>The smallest value of any item.</td>
</tr>
<tr>
<td>Min Sel</td>
<td>The smallest value of any selected item.</td>
</tr>
<tr>
<td>Mode</td>
<td>The value with the most items.</td>
</tr>
<tr>
<td>Mode Sel</td>
<td>The value with the most selected items.</td>
</tr>
<tr>
<td>Selected</td>
<td>The total number of selected items.</td>
</tr>
<tr>
<td>Sum Sel</td>
<td>The sum of all of the selected items.</td>
</tr>
<tr>
<td>Std Dev</td>
<td>The standard deviation for all items.</td>
</tr>
<tr>
<td>Std Sel</td>
<td>The standard deviation for selected items.</td>
</tr>
<tr>
<td>Sum</td>
<td>The sum of all items.</td>
</tr>
<tr>
<td>Unique</td>
<td>The number of unique values.</td>
</tr>
<tr>
<td>Uniq Sel</td>
<td>The number of unique values for selected items.</td>
</tr>
</tbody>
</table>
**Reference: Counts Tab**

The following image shows the Counts tab in the Visual Discovery Properties dialog box.

---

**Simple statistics only**

Presents a subset of the statistics.

**Statistics on selected subset only**

Presents statistics about the selected item(s).

---

**Reference: Counts Pop-up Menu**

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

**Show unselected**

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and click **Select All**.

**Indent text**

Shows indented text fields if the text has leading white space. When this option is not selected, the leading white space is ignored in text fields so that all fields start against the left column border.

**Simple only**

Presents a subset of the statistics.

**Selected only**

Presents statistics about the selected item(s).

**Original order**

Restores the graph to the initial sort order.
**Find in Column**
Enables you to search for a specific value.

**Export**
Exports the data to a file of the type you specify, for example, Microsoft Excel®.

**Full Size**
Shows text in a normal, readable size.

**Fit Selected**
Zooms the data sheet so it contains all the rows of data, some of which may be overplotted to fit.

**Fit All**
Shows the entire table in the current window. If there are fewer table rows than will fit in the window at full size, then the lines are shown in a larger font with more spacing. If there are more lines than will fit, then they are reduced to a smaller size, with a minimum of 1 pixel high. If all table rows does not fit at 1 pixel high, then lines are overplotted to allow all to fit. When values are overplotted, the line that is the longest or with the hottest color is drawn on the top, obscuring all others under it.

**One Line/Pixel**
Draws text as one-pixel-high lines. It is helpful when you need to reduce the size of the text to see more of the data. Depending on how many lines you have in your table, this may still require paging to see all rows.

**Undo**
Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

**Redo**
Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

**Select All**
Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.
Unselect All

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

Toggle All

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

Exclude Unselected

Excludes (temporarily removes) items from the graph.

Restore Excluded

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

Save Image

Enables you to save the graph to a GIF or JPEG file.

Copy Image

Enables you to copy the selected component and paste it to another file.

Properties

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.

Data Constellations

Data constellations, or constellation graphs, depict multiple data sets or groups of data sets with particular attributes and map the association between them. They are called constellations because they are made up of numerous stars or nodes. Each represents a specific data value that is distanced from and connected to each other on the diagram plane in proportion to the strength or weakness of their relationship. Data constellations are best suited for plotting and analyzing large, complex data sets in a single view. Additional data attributes and relationships can also be displayed by adjusting node and link size, style, and color based on data values.
The following image shows an example of a data constellation.

With WebFOCUS visualization features, you can fully understand and explore relationships by creating complete, easy-to-read data constellations. You can further enhance these constellations by:

- Controlling node and link appearance based on data values.
- Positioning nodes automatically, based on the strength of the relationship, or manually, based on preferences or other criteria.
- Labeling nodes and links for easier identification.

Data constellations are a graphic representation that show relationships among data, using links that connect nodes. They can be helpful when you are analyzing, for example, hierarchical data, types of calls over a telephone system or help desk, order tracking for factory or retail distribution centers, or process characteristics related to product flaws where a node may represent a city or other location. Lines, in this case, can represent characteristics of a call, system problem, or production line environment variable.
Use data constellations when you have mixed data types and want to visualize and analyze three or more fields. While allowing you to analyze relationships among three or more objects, this component shows the strength of relationships (affinity) between and among items through node and link size and appearance, placement, and coloring. Different icons can be used with nodes or instead of nodes to provide more information about the categories of items within your data set.

**Note:** Data for data constellations must be prepared for this component. All data relationships must be defined in one file. A second input file contains information about the nodes. If your application has not been designed with these considerations in mind, you may not be able to explore the relationships you want. For an example, see *Tutorial: Building a Visual Discovery Analytic Dashboard with Advanced Chart Controls* on page 65 or for more information, see *Data Constellation Maps* on page 143.

### Weighting a Graph

In a data constellation, the link weight shows the strength of attraction between nodes, which is also accomplished using a field. This is used for placement and does not visibly change the graph.

**Procedure:** **How to Weight a Graph**

Select the field to weight your data constellation from the Placement tab in the Properties dialog box.

### Data Constellation Maps

When analysis of information with a geographical or spatial component is required, a data constellation can also be presented as a map by associating the nodes on the constellation with map images, and geo-code data, such as countries, cities, and zip codes with latitude and longitude coordinates. Data constellation maps are helpful when you need to distinguish regional variations in specific attributes or determine links between specific locations. As with standard data constellations, the height, shape, size, and color of nodes and links on a constellation map can be manipulated to represent other data relationships or characteristics.
The following image shows an example of a data constellation map.

WebFOCUS Visual Discovery includes complete maps of the world, as well as the United States, Canada, and Mexico, with geo-code data for countries, over 400 worldwide cities, and U.S. zip codes. You can find the maps supplied with Visual Discovery in the visdis directory installed with Developer Studio. For example, on Windows, the default directory is \ibi\DevStudio81\ibi_html\visdis\Maps.

Custom maps, such as floor plans and other spatial images, can also be supported by using bitmap images as a base with associated geo-code data. You can also:

- Control node and link appearance based on data values.
- Position nodes based on the map image.
- Color-code specific regions on the map or globe.
- Label nodes and links for easier identification.

The data constellation component supports image maps and vector maps. A vector map is created from a table of data that specifies a series of detailed latitude and longitude coordinates that are used to plot a geographical area. Vector map data can be specified in place of, or in addition to, an image map. One advantage of a vector map is that you can color and extrude the actual map elements. For example, you can color code countries on a world map to reflect population. Maps can also be placed on a sphere to produce a globe.

From the Placement tab, you can overlay an image on the display and position the nodes (bars) according to the x-value and y-value of the map image (for example, longitude and latitude values).
The image you use for the map should be generated by a map program for specific latitude and longitude. The image should be generated with Mercator Projection (most common map programs have this).

What is Mercator Projection? Since the Earth is round and we want to create a flat 2D image, there will be some sort of distortion. Different projections are developed to solve the distortion problem and Mercator is one of them. If a different projection is used, the data points will not be mapped correctly because of the distortion. For example, a city in Florida may appear in the ocean.

The image is defined by: lower left corner Longitude, Latitude and upper-right corner Longitude, Latitude.

For more information, see *Data Constellations* on page 141.

**Procedure: How to Set Up Nodes and Links**

1. Click the *Nodes/Links* tab in the Visual Discovery Properties dialog box.
2. In the Nodes field, set:
   - *Size* to determine the relative size of the node. The size of the node is related to the size of the field value. Select a field from the drop-down list.
   - *Style* to determine the shape of the node. A small set of node styles is mapped to the values in the selected field in sort order. Shapes are filled circle, filled square, filled pentagon, filled rectangle, framed circle, framed square, framed pentagon, and framed rectangle. Select a field from the drop-down list.
   - *Label* to specify the text for the node label. For example, if you had a City field, the city name appears when a user hovers over a node.
   - *Height* to the field you want the nodes to represent. This in effect puts the display in 3D mode, where the nodes appear as 3D bars. The height of the bars will reflect the values in the field.
   - *Scale* to adjust the relative size of nodes. Move the slider to the right to increase the size or to the left to decrease the size of the nodes.
3. In the Links field, set:
   - *Size* to specify the line width. Select a field from the drop-down list.
Style to determine the shape of the link. A small set of link styles is mapped to the values in the selected field in sort order. Shapes are filled circle, filled square, filled pentagon, filled rectangle, framed circle, framed square, framed pentagon, and framed rectangle. Select a field from the drop-down list.

Label to specify the text that describes the link. Select a field from the drop-down list.

Scale to adjust the relative size of links. Move the slider to the right for larger links and to the left for smaller links.

Directional to draw links as directed, with arrowheads showing the direction of the link. To use directional links, your data must support to/from links. You can specify these relationships on the Data tab.

4. Click Apply and then click OK.

Note:

- Nodes are the glyphs (3D graphics objects that look like extruded boxes or skyscrapers) that overlay the map image to represent geographical entities, in this case, cities.
- Links represent a relationship between nodes. In this case, the relationship is a movement of goods between distribution centers.
- In many cases, a relationship may not exist between nodes that you want to visually represent. In those cases, you still need to provide a table, but simply give it a dummy table that has two fields with values that do not match any of the values in the field selected from the nodes table. Here is a sample table that you can use:

<table>
<thead>
<tr>
<th><em>dummynode1</em></th>
<th><em>dummynode2</em></th>
</tr>
</thead>
<tbody>
<tr>
<td><em>dummynode1</em></td>
<td><em>dummynode2</em></td>
</tr>
</tbody>
</table>

Procedure: How to Set the Placement Properties of an Image

1. Click the Placement tab in the Visual Discovery Properties dialog box.

Add the map image and the coordinates for longitude and latitude. The image must be in BMP or JPEG (extension .jpg or .jpeg) format. For more information on image requirements, access Visual Discovery online Help and search for the applicable JavaScript API topics.

In the Position File input area, three distinct parameter strings are required, each separated by a space, as follows,

longfield, latfield 'imagepath' minmax1~ minmax2
where:

`longfield, latfield`

Are the actual field names in the data source for the fields that contain the X,Y (longitude
and latitude) coordinates for the nodes, respectively. The fields `longfield` and `latfield` are
case-sensitive.

`imagepath`

Is the full path of the map image. Use the Browse button to enter this value.

`minmax1~ minmax2`

Are the minimum X and Y (lower-left corner of the map) and maximum X and Y (upper-
right corner of the map) values, separated by a tilde (~) and a space.

2. Click `Browse` and navigate to the map file.

3. Click in the Position File text box and preceding the image path, enter the field names for
the X, Y (longitude and latitude) coordinates. Ensure there is a space between Latitude and
the path designation. For example:

   Longitude, Latitude 'C:\ibi\apps\session\usMainlandDark.jpg'

4. In the Position File text box, go to the end of the string. Add the minimum X and Y and
maximum X and Y values for the map image. Ensure the values are separated by a tilde (~)
and a space. For example:

   Longitude, Latitude 'C:\ibi\apps\session\usMainlandDark.jpg' -125.5,23.5~ -67,50
Reference: Data Constellations Tab

The following image shows the Data Constellations tab in the Visual Discovery Properties dialog box.

Mouse

Selects

Uses the mouse to select data.

Labels

Uses the mouse to label nodes and links.

Label

When the mouse is used to label items, fields in the Label section can be used.

Label selected

Labels the selected items.

Clear Labels

Removes all labels.

Node and Link Selection

Enables you to show nodes and links in your graph.

Options available from the drop-down menu are Nodes Only, Links Only, and Nodes and Links. Available options in the linking area are No Linking, Link Both Ways, Nodes -> Links, and Links -> Nodes. For more information, see Nodes/Links Tab on page 150.
**Link External Selections**

Propagates links to other visualization components.

**Show Unselected**

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box or use the right mouse button menu in the view and choose **Select All**.

**Select a Subgraph**

**One Step**

Increases the selection by including nodes at the other end of the currently selected links. One Step is the same as performing both Step Out and Step In simultaneously.

**Step In**

Increases the selection by including nodes on incoming links from the currently selected set.

**Step Out**

Increases the selection by including nodes on outgoing links from the currently selected set.

**Component**

Increases the selection by including all nodes that are reachable from the current selection (the component).
**Reference: Nodes/Links Tab**

The following image shows an example of the Nodes/Links tab in the Visual Discovery Properties dialog box.

![Nodes/Links Tab](image)

**Nodes**

Sets the node Size, Style, Label, Height, and Scale properties for the nodes in your data constellation.

**Links**

Sets the link Size, Style, Label, Scale, and Directional properties for the links in your data constellation.

For more information, see *How to Set Up Nodes and Links* on page 145.
**Reference: Placement Tab**

The following image shows the Placement tab in the Visual Discovery Properties dialog box.

![Placement Tab Image](image)

**Position File**

The name of a file that contains saved positioning information. If supplied, this file will be read and those positions used for the data visualization nodes. Use Browse to find the placement position file. The complete path to the file can also be typed in the Position File field.

**Read**

Reads an existing position file.

**Write**

Writes or saves the positioning of a graph.

**Link Weight**

Enables you to select a field to weight the link by.

**Position**

Specifies the position of the nodes. You can position nodes as a hex grid, angular tree, circular shape, top-down tree, map, or globe. If you choose a map, you must specify the longitude and latitude values in the Position File field.
**Swap**

Improves the placement by exchanging nodes between current positions. When hex grid placement is used, swapping nodes may further improve the placement, based on moving strongly attracted nodes closer together. Strength of attraction is based on the assignment of a numeric field to a link as the link weight.

Because graph improvement can be time-consuming, use the slider to specify a certain length of time, in seconds, for swapping to occur.

**Move**

Improves the placement by moving nodes that are strongly connected closer together.

When hex grid placement is used, another improvement can be made after swapping, by moving nodes closer together off the initial grid, based on the strength of attraction.

Use the slider to specify the length of time to move, in seconds.

**Apart**

Readjusts the space between nodes if the Move option places them too close. Use the slider to specify the length of time to readjust, in seconds.

**Stop Placement**

Stops the placement process, keeping the last positioning.

---

**Reference:** Data Constellation and Data Constellation Map Pop-up Menu

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing a component in HTML Composer.

**Show Unselected**

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and click Select *All*.

**Selection Type**

Enables you to select nodes and/or links that appear in your graph.

Options available from the pull-down menu are Nothing, Nodes, Links, or Nodes and Links.
**Selection Linking**

Determines how selection is propagated between nodes and links.

Options available from the pull-down menu are No Linking, Nodes to Links, Links to Nodes, Both Ways. Finer characteristics of nodes and links are defined in the Nodes and Links tab.

**Label Selected**

Displays labels for the selected data.

**Directional**

Adds or removes arrowheads showing the direction of the link.

**Label Node/Link 'name' (Data Constellations only)**

Adds or removes the label for the selected node or link.

**SHIFT+CTRL+RMB (Data Constellation Maps only)**

Changes the action that occurs when you press the Shift + Ctrl + RMB (right mouse button) keys.

**Glyph (Data Constellation Maps only)**

Changes the shape of the glyphs.

**Undo**

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

**Redo**

Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

**Select All**

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

**Unselect All**

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).
Toggle All

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

Exclude Unselected

Excludes (temporarily removes) items from the graph.

Restore Excluded

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

Save Image

Enables you to save the graph to a GIF or JPEG file.

Copy Image

Enables you to copy the selected component and paste it to another file.

Extruded (Data Constellation Maps only)

In 3D mode in run time, glyphs are drawn from the height to the floor, allowing nodes to be treated like a bar chart on a plane.

Label Item (Data Constellation Maps only)

Enables you to display or suppress the label text. When you right-click a glyph (node or link), this option changes from Label Item, to the text that identifies the selected node or link. For example, if you right-click a node that represents data for Dallas, this option appears as Label Node “Dallas.”

Properties

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.

Data Sheets

A data sheet creates a table-style view of a set of fields so you can easily uncover interactions and patterns. Data sheets are particularly useful for viewing dynamic top or bottom lists or dividing data into groups for comparison to identify both common and unique attributes.
An example of a data sheet is shown in the following image.

<table>
<thead>
<tr>
<th>City</th>
<th>Capacity</th>
<th>RevPerSquareFoot</th>
<th>Utilization Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Denver</td>
<td>20278</td>
<td>203.51</td>
<td>65.4</td>
</tr>
<tr>
<td>Atlanta</td>
<td>28632</td>
<td>181.29</td>
<td>59.6</td>
</tr>
<tr>
<td>Baltimore</td>
<td>30825</td>
<td>137.23</td>
<td>50.5</td>
</tr>
<tr>
<td>Boston</td>
<td>24385</td>
<td>216.81</td>
<td>64.6</td>
</tr>
<tr>
<td>Chicago</td>
<td>20590</td>
<td>142.27</td>
<td>62.0</td>
</tr>
<tr>
<td>Cleveland</td>
<td>33154</td>
<td>185.35</td>
<td>56.8</td>
</tr>
<tr>
<td>Dallas</td>
<td>32839</td>
<td>200.65</td>
<td>60.2</td>
</tr>
<tr>
<td>Denver</td>
<td>20275</td>
<td>203.57</td>
<td>68.4</td>
</tr>
<tr>
<td>Detroit</td>
<td>23638</td>
<td>193.93</td>
<td>64.1</td>
</tr>
</tbody>
</table>

Data sheets created using WebFOCUS Visual Discovery enable you to:

- Pan and zoom to alter viewpoint.
- Display as many fields as your data source contains.
- Squash the data to reveal patterns across several variables by comparing hundreds to thousands of rows at once.
- Interact to identify interesting subnetworks.
- Combine rows into line representation.
- Sort the table by one or more fields.
- Search on a selected column.
- Perform textual searches using specific text or substrings of text.
- Export selected subsets of rows and columns of data to a file.
- Filter data that will automatically be reflected in the other visualization components in your dashboard.
Reference:  Data Sheet Tab

The following image shows the Data Sheet tab in the Visual Discovery Properties dialog box.

Line Representation

Full Size

Shows text in a normal, readable size.

Pixel/line

Draws text as one-pixel-high lines. This is helpful when you need to reduce the size of the text to see more of the data. Depending on how many lines you have in your table, this may still require paging to see all rows.

Fit All

Shows the entire table in the current window. If there are fewer table rows than will fit in the window at full size, then the lines are shown in a larger font with more spacing. If there are more lines than will fit (the more common case), then they are reduced to a smaller size, with a minimum of 1 pixel high. If all table rows does not fit at 1 pixel high, then lines are overplotted to allow all to fit. When values are overplotted, the line that is longest or with the hottest color is drawn on the top, obscuring all others under it.

Show Unselected

Shows unselected data in gray. If the Show Unselected check box is not selected, unselected data is omitted from the display.

To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click Select All.
**Indent Text**

Indent text fields if the text has leading white space. When this option is not selected the leading white space is ignored in text fields, so that all fields start against the left column border.

**Scale Mode**

Shows the reduced line representation option. When this option is not selected, the display is locked into text mode.

**Tool Tips**

Displays the entire string of a truncated line when the cursor is placed in the column.

**Display Focus Line**

Displays the name of each selected (in focus) field.

**Sort By**

Sorts the glyphs by the specified field.

**Reverse Sort By**

Reverses the sort order.

**Remove**

Removes the highlighted field from the sort.

**Reference: Data Sheet Pop-up Menu**

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

**Show Unselected**

Shows unselected data in gray. If Show Unselected is not checked, unselected data is omitted from the display.

To add unselected data, either turn on Show Unselected in the Properties dialog box, or use the right mouse button menu in the view and choose Select All.

**Indent Text**

Indent text fields if the text has leading white space. When this option is not selected, the leading white space is ignored in text fields, so that all fields start against the left column border.
**Original Order**
Restores the graph to the initial sort order.

**Find in column**
Enables you to search for a specific value.

**Export**
Saves the data to a file.

**Full Size**
Shows text in a normal, readable size.

**Fit Selected**
Zooms the data sheet so it contains all the rows of data, some of which may be overplotted to fit.

**Fit All**
Shows the entire table in the current window. If there are fewer table rows than will fit in the window, then lines are shown in a larger font with more spacing. If there are more lines than will fit, then they are reduced to a smaller size, with a minimum of 1 pixel high. If all table rows does not fit at 1 pixel high, then lines are overplotted to allow all to fit. When values are overplotted, the line that is the longest or with the hottest color is drawn on the top, obscuring all others under it.

**One Line/Pixel**
Draws text as one-pixel-high lines. This is helpful when you need to reduce the size of the text to see more of the data. Depending on how many lines you have in your table, this may still require paging to see all rows.

**Undo**
Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

**Redo**
Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.
**Select All**

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

**Unselect All**

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

**Toggle All**

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

**Exclude Unselected**

Excludes (temporarily removes) items from the graph.

**Restore Excluded**

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

**Save Image**

Enables you to save the graph to a GIF or JPEG file.

**Copy Image**

Enables you to copy the selected component and paste it to another file.

**Properties**

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.

**Multiscapes**

Multiscapes provide a visual representation of the interaction or relationship between two or more associated data fields by plotting one variable on the x-axis and one or more variables on the y-axis. Multiscapes are a very effective means for understanding large bar charts with multiple categories, and are typically used to compare objects based on several attributes at the same time. A two-way multiscape plots one variable on the x-axis and one on the y-axis. N-way multiscapes plot one variable on the x-axis and multiple variables on the y-axis. Both two-way and n-way multiscapes are available in three-dimensional (3D) versions.
The following image shows an example of a multiscapes diagram.

With WebFOCUS Visual Discovery, you can generate two-dimensional or three-dimensional multiscapes to rapidly find patterns between sets of statistics characterizing an object. These multiscapes can accommodate scenarios with hundreds of bars along each axis, and you can touch any individual bar to highlight its categories, sweep across a range of bars to see detail, or interactively isolate groups of bars by choosing other attributes.

Other features include:

- **Multiple bar shapes.**
- **Ordering and clustering.** Groups similar data values together on the diagram.
- **Panning, zooming, and rotating.** Views information from multiple points of view and conveniently navigate through large three-dimensional diagrams.
- **Weighting.** Displays bars in accordance to a bias.

Using the default Weight By value to size the glyphs, you can easily discover the variables that are most frequently associated with each other in the data records (that is, are most strongly related) by finding the largest glyphs. By changing the Weight By variable, you can change the size of the multiscape glyphs to represent the value of a third variable from the data set. This enables you to compare three variables at once in a 2D display.
Procedure: How to Reorder a Multiscape

1. In the Visual Discovery Properties dialog box, click the Multiscape tab.
2. In the Row Order or Column Order field, select:
   - Original to list the row or column labels based on the order in which they appear in the data source.
   - Name to list the row or column labels on the associated axis alphabetically by name.
   - Count to list the row or column labels on the associated axis by the count of the number of glyphs in each row or column (from highest to lowest).
   - Cluster to list row or column labels on the associated axis with categories of the same magnitude clustered together.
3. Click Apply, and then click OK.

Tip: From the pop-up menu, click Column Order or Row Order.

Procedure: How to Change the Display Method and Select the Field to Weight By

1. In the Visual Discovery Properties dialog box, click the Multiscape tab.
2. In the Display Method field, select the desired glyph shape:
   - Bubble. Items are shown as a circle, the size of which is determined by Weight By. In two dimensions, items are shown as circles or dots. Items in three dimensions appear as cylinders.
   - Block. Items are shown as a rectangle (depending on the shape of the window containing the graph). The size of the rectangle is determined by Weight By. Differences in the size of block glyphs (due to its weight) are shown by increased or decreased heights of the glyph. In two dimensions, items are shown as a small bar, rectangle, or square. Items in three dimensions appear as a box.
   - Side block. Is a set of two rectangles, side by side. The rectangle on the left (always colored gray) represents the total population of records represented by the glyph. The rectangle on the right represents the portion of the records represented by the glyphs that are selected. The size of the side block glyph (including both rectangles) is determined by Weight By. If the Show Unselected option is checked and a side block glyph is unselected, the glyph will be represented on the display by only the left, gray rectangle. The side block glyph is useful for comparing the population of total records compared to the selected records.
Multiscapes

- **Spine plot.** Items are shown as a bar whose width represents the number of cases and the comparative percentages of items in each case. Glyphs are rectangles, the size of which is determined by the Weight By variable. Differences in the size of glyphs (due to its weight) are shown by the increased or decreased width of the glyph. In 3D, glyphs are boxes.

- **3D Surface.** Displays the glyph as a pyramid, the height of which is determined by Weight By. This option is available only after 3D Display is selected.

3. From the Weight By drop-down list, select the field you want to weight the shapes by.

   By default, the Weight By value is set to <none>. The default size of the multiscape glyphs is proportional to the number of data records represented by the glyph.

4. Click **Apply**, and then click **OK**.

   **Tip:** From the pop-up menu, click **Display As**.

**Procedure: How to Color a Multiscape By Size**

1. In the Visual Discovery Properties dialog box, click the **Multiscape** tab.

2. Click **Color By Size**.

   The glyphs in the multiscape are immediately recolored so that each glyph with the same height is the same color. The color scale used for the coloring is the default scale unless another scale is set on the Colors tab. The size of the glyphs is determined by the Weight By value.

3. Click **Apply**.

   **Note:**

   - To change the color of the multiscape glyphs to encode any other value besides the size of the glyph, use the field in the Color Using Field section of the Colors tab.

   - If two y-variables are selected, you are not able to color by the size.

   - If you apply a different color scale to the graph, you need to press the Color By Size button again to use the new scale for this coloring.

   - To restore the original coloring, go to the Colors tab. In the Color Using Field section, click **none**, click **Apply**, and then click **OK**.


**Reference: Multiscape Tab**

The following image shows the Multiscape tab in the Visual Discovery Properties dialog box.

![Multiscape Tab Image]

**Row Order**

Reorders the rows in a multiscape. See *How to Reorder a Multiscape* on page 161.

**Display Method**

Changes the display method. See *How to Change the Display Method and Select the Field to Weight By* on page 161.

**Color By Size**

Recolors the graph so that each glyph with the same height is the same color. This lets you easily identify glyphs that have common values.

The Color Scale used for the coloring is the default scale unless another scale is set on the Colors tab. See *How to Color a Multiscape By Size* on page 162.

**Column Order**

Reorders the columns in a multiscape. See *How to Reorder a Multiscape* on page 161.

**Weight By**

Is the variable (data field) for the option selected in the Display Method field. See *How to Change the Display Method and Select the Field to Weight By* on page 161.
Sum positive & negative weights

Adds negative and positive weights together (creates two values, the sum of all negative weights and the sum of all positive weights, shown in one glyph). When this check box is not selected, the negative and positive values are added together in one value. For example, if the negative and positive weights are added separately and the values are –8, –7, 5, and 10, the glyph shows a value of –15, +15, and the glyph spans from –15 to +15. When negative and positive weights are added together, the value is 0 and the glyph rests on 0.

Show grid for rows/columns

Displays a grid.

Show Unselected

Shows unselected data in gray. If the Show Unselected check box is not selected, unselected data is omitted from the display.

To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click Select All.

In 3D graphs, the Show Unselected check box must be selected in the initial visualization component if you want to make unselected items transparent.

3D display

Displays glyphs in three dimensions. This check box must be selected for the 3D Surface option to become available.

Reference: Multiscape Pop-up Menu

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

Show grid

Displays a grid.

Display as

Changes the appearance of the glyphs. Options are Bubble, Block, Side Block, SpinePlot, and 3D Surface.

Column order

Specifies the order in which items are presented. Options are Original, Name, Count, and Cluster.
Row order

Specifies the order in which items are presented in rows. Options are Original, Name, Count, and Cluster.

Show unselected

Shows unselected data in gray. If the Show Unselected check box is not selected, unselected data is omitted from the display.

To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click Select All.

Shift + CTRL + RMB

Enables you to use the mouse (RMB, which is the Right Mouse Button) with the Shift and Ctrl keys to Zoom, Rotate XY (rotate the x-axis and y-axis), or Rotate Z (rotate the z-axis).

This option is only available for 3D multiscapes.

Undo

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

Redo

Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

Select All

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

Unselect All

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

Toggle All

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

Exclude Unselected

Excludes (temporarily removes) items from the graph.
**Restore Excluded**

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

**Save Image**

Saves the graph to a GIF or JPEG file.

**Copy Image**

Copies the selected component and pastes it to another file.

**Properties**

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.

**Creating a 3D Multiscape**

In a 3D graph, some trends or other information might appear that you might not have considered on a 2D graph. 3D graphs are helpful when you want to look at different aspects, attributes, or characteristics of one data item at the same time.

One thing to be aware of when using a 3D multiscape is perspective. At times, an object in the foreground may appear larger than objects in the background. If you are comparing the relative size of objects, perspective could lead you to believe objects in the back of a graph are smaller than objects in the front of a graph, when, in fact, they are equal. You can avoid this by choosing the Parallel option in the 3D tab, which presents glyphs more accurately.

From the 3D tab, you can also control the color or transparency of unselected glyphs (to gray or color), the background walls for the graph, and the size of the x-axis, y-axis, or z-axis.

**Procedure: How to Create a 3D Multiscape**

1. Click the Multiscape tab in the Visual Discovery Properties dialog box.
2. Click the 3D Display option.
3. Change the Display Method, if necessary.
4. Click the 3D tab to customize your 3D multiscape. For details on the available options, see 3D Tab on page 167.
5. Click Apply after you have made your changes.
**Reference: 3D Tab**

The following image shows the 3D tab in the Visual Discovery Properties dialog box.

### Projection

**Perspective**

Displays glyphs in the foreground slightly larger than the glyphs in the background, which produces the expected illusion of perspective. This is the default.

**Parallel**

Glyphs are not changed to give the illusion of perspective. For this reason, the glyphs may give a more accurate representation of the data.

### Unselected Drawing

**Gray**

Displays unselected items in gray, so it appears as if they fade from view. The Gray color scale uses shades of black and white to show differences or similarities between or among items.

**Colored**

Displays unselected items in a color.

### Transparency

Displays unselected items as transparent compared to the selected items. You can adjust the degree of transparency by moving the slider to the right or to the left.
**Drawing Precision**

Indicates how accurately the graph is rendered. Because the basic unit of drawing (pixel) is square, the accuracy of the drawing depends on how many pixels are used to draw a graph. Select High, Medium, or Low drawing precision.

Note that the High option, while more accurate, takes longer to render.

**Mouse + Keys do...**

Enables you to use the mouse and various keystrokes to add functionality to a 3D graph. You can use keystrokes and the mouse to pan, zoom, rotate, select, show field level help, and turn continuous indicate on.

**Back walls**

Displays background walls on the graph.

**Axis Range (Immediate Effect)**

Adjusts the length of the x-axis, y-axis, or z-axis. Move the slider to the right to make the axis longer, move the slider to the left to make the axis shorter. By default, the axes are medium length.

**Paraboxes**

A parabox is a hybrid of box plots and parallel coordinate plots, and is made up of multiple columns. The first contains specific values from a data group (each displayed as a bubble, sized to demonstrate the number of records it represents), with the remaining columns each representing a specific characteristic of that group. Paraboxes can give you an overview of the distribution of values in a set of fields from a table and provide a simple summary of how a subset of data differs from the whole. Paraboxes are effective for simultaneously measuring and analyzing numerous attributes and complex relationships among multiple fields.
The following image shows an example of a parabox.

WebFOCUS Visual Discovery offers a unique parabox component. You can create intuitive paraboxes, then further enhance them by drawing lines that connect column values, so interaction patterns can be detected between fields and abnormalities that fall outside the regular range can be identified. You can also perform comparisons by population or selection, access individual data values, and choose from multiple plot styles.

Trade-off, constraints, and optimization analyses are just some of the analyses that can be performed using the parabox. Use the parabox to:

- See how values within a categorical or numerical variable are distributed across all cases.
- Identify outliers and medians.
- See where 50% and 90% of the data should appear.
- Show correlations among multiple variables that are displayed on parallel axes.
- Show subsets in relation to the whole data set.
- Study characteristics of the groups produced by clustering.
- View large data sets with three or more fields.

**Reference:** What Is a Boxplot?

A boxplot shows ranges or distribution characteristics of values of selected categorical data. The central tendency and range or statistical variations are computed for each category of data and the selected values are presented in a box. This type of representation is useful when you want to compare a subset of a population to the whole population.
A boxplot provides a great deal of information. If selected items are visualized, two boxplots provide information. The boxplot always displays an outer and inner box. It represents all the items in the graph. The outer (dark gray) box shows where 95% of the data should lie according to a simple statistical model. Points outside the outer box area (often called outliers) are drawn as individual points on the central axis. The inner (lighter gray) box represents 50% of the data. In other words, it represents the middle half of the data in the distribution. The line across the box represents the median.

The following image shows an example of a boxplot.

```
Inner Fence
```

```
Outer Box

Inner Box
```

```
Median

Minimum Value
```

The optional boxplot is displayed in pink (by default). The outside lines (inner fence and minimum value or whiskers) are drawn from the box to the smallest and largest values.

If the selected items are all of the items in the set, the two boxes appear in the same space. That is, the inner fence and the minimum values from the optional box plot are the top and bottom edges of the first box plot. The median lines overlap.

You are more likely, however, to select items that are a subset of items depicted in the whole graph. In this case, depending on the values of the items in the subset, the optional box plot might fill above and/or below the first box plot.
**Procedure:** How to Set Parabox Presentation Options

1. Right-click the graph you want to change in the report output.
2. Select the desired strip representation:
   - **As Bubbles** is a type of strip representation where a distinct field is shown as a circle whose area is proportional to the number of cases in that field. Fields are sorted from bottom to top. The bubble option is best used for displaying data with few distinct fields.
   - **As Boxplot** is a type of strip representation used to plot continuous and integer data. Boxplots help you to see the basic tendency of data or develop an idea about the range of values.
   - **As DotStrip** is a type of strip representation where the data items are drawn as dots positioned linearly between the bottom of the visualization component (representing the minimum value) and the top (representing the maximum value). Dots are drawn as close to the central axis of the strip as possible, but are placed beside existing points. The effect is to show a number of points at the same y-value as a horizontal bar. Highlighted points are drawn first (and in the center) and are colored appropriately: x-values are colored in gray (by default) and y-values are colored in yellow (by default).

   The glyph changes to the strip representation that you selected.

**Note:** Only those options that are applicable to a specific data type are available for its parabox glyph. For example, the As Bubbles option is not available for real numbers.

**Reference:** Ordering Data in a Parabox

The ordering icons appear in the right corner of a column. The icons and their meanings are described in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>The data is in its original order.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>The data is sorted by size, from largest (at the bottom) to smallest (at the top).</td>
</tr>
</tbody>
</table>
### Paraboxes

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⬇️</td>
<td>The data is sorted by size, from smallest (at the bottom) to largest (at the top).</td>
</tr>
<tr>
<td>🔄</td>
<td>The data is sorted by label, from a (at the bottom) to z (at the top).</td>
</tr>
<tr>
<td>⬆️</td>
<td>The data is sorted by label, from z (at the bottom) to a (at the top).</td>
</tr>
<tr>
<td>📈</td>
<td>The weighting field is shown in this strip. Active only when a weight by field has been selected.</td>
</tr>
</tbody>
</table>

**Reference: Parabox Tab**

The following image shows the Parabox tab in the Visual Discovery Properties dialog box.

![Parabox Tab](image)

**Strip Options**

**Show Selected Subset**

Displays an optional box plot in yellow (by default). The outside lines (inner fence and minimum value or whiskers) are drawn from the box to the smallest and the largest values of the selected subset.
Show Labels
Displays labels that explain the meaning of the glyphs on the graph.

Numerics Use Same Scale
In a parabox, the presentation options can be set to show Parallel Axis, Same Scale for Boxplots, and/or Show Selection. If you want the boxplots to be created using the same scale as the other glyphs, select Same Scale for Boxplots. By default, the boxplots are drawn to make them legible. In this case, the glyphs are not likely to be drawn to the same scale.

Bubble Options
When you weight a field with a negative value, select:

☑ Size From Magnitude to make the bubbles a size that relates to its absolute value, instead of its relative value.

☑ Size From Smallest Value to make the bubbles a size relative to the smallest bubble value in the strip.

Negative values are shown as unfilled circles.

Parallel Axes

Show Parallel Axes
When selected, parallel axis lines connect the fields.

Show Unselected Lines
Shows unselected data in gray. If the Show Unselected Lines check box is not selected, unselected data is omitted from the display.

To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click Select All.

Use Background2 Color
Select this check box to display the parallel axis for unselected rows in the color defined as Background2 on the Colors tab. This makes the parallel axis for the unselected rows blend into the background. When the Use Background2 Color check box is not selected, the parallel axis for unselected rows uses the standard unselected color.

Tool Tips
Displays the entire string of a truncated line when the cursor is placed in the column.
**Reference:** Parabox Pop-up Menu

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

**Note:** Only those options that are applicable to a specific data type are available for the parabox glyph. For example, string data types show only Parallel Axes, Show Selection, and Same Size. Whereas all options are available for integer data types.

**Parallel Axes**

When selected, lines connect the fields. When Parallel Axes is not selected, no lines connect the fields.

**Show Selection**

When selected, an optional box plot is displayed in yellow (by default). The outside lines (inner fence and minimum value or whiskers) are drawn from the box to the smallest and the largest values of the selected subset.

**Same Scale**

Shows all numbers in all columns in the graph on the same scale.

**As Bubbles, As Boxplot, As Dot Strip**

Changes the type of strip representation. For more information, see How to Set Parabox Presentation Options on page 171.

**Undo**

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

**Redo**

Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

**Select All**

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.
Unselect All

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

Toggle All

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

Exclude Unselected

Excludes (temporarily removes) items from the graph.

Restore Excluded

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

Save Image

Enables you to save the graph to a GIF or JPEG file.

Copy Image

Enables you to copy the selected component and paste it to another file.

Properties

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.

Scatter Plots

A scatter plot, also called a scatter gram or scatter diagram, is used to investigate the possible association between two variables that both relate to the same event by distributing a series of points or nodes, each representing a value in the data set, across a grid. Scatter plots are used to demonstrate cause-and-effect, and evaluate the nature and degree of associations between two attributes.
Scatter plots share many of the characteristics of basic line graphs, and data can be plotted using variable scales on both axes. You can use the scatter plot to analyze correlations, clusters of points, patterns, and the influence of one variable upon another. That is, plotting two groups of numbers as one series of XY coordinates. Scatter plots can also be used to examine how the value of Y changes as a function of X, including changes over time if the x-axis is a time sequence.

The following image shows an example of a scatter plot.

With WebFOCUS Visual Discovery, you can easily visualize correlations between two items. Additionally, scatter plots can be enhanced by:

- Adjusting node size, shape, and color.
- Superimposing trend lines to highlight patterns in the whole data set or selected items.
- Including jitter nodes to show overplotting.
- Adding non-linear axes.

The scatter plot accepts continuous variables. It does not accept string variables. Unselected items are drawn as open circles and selected values are drawn as filled circles of either the default highlight color or the color used to code the data.

**Inserting a Trend Line in a Scatter Plot**

You can add a trend line to a data series in a scatter plot. Trend lines are commonly used to study problems of prediction (regression analysis) and to smooth fluctuations in data to show the pattern or trend more clearly. The trend option can show or hide trend lines for both the data and the selected subset.
The detail options on the trend menu are used for drawing non-trend type lines through the scatter plot data. Each of the options draws a line connecting dots in the direction of the x-axis. The difference in the options lies in how the line is drawn when dots with the same x-value and different y-values are encountered.

**Procedure: How to Use a Trend Line**

1. In the Visual Discovery Properties dialog box, click the Scatter tab.
2. In the Trend Line field, select:
   - *Local* to insert a trend line which curves to fit the data points.
   - *Linear* to insert a linear regression trend line that is drawn through all loaded points. The line approximates all the points in the overall scatter plot. This trend line uses the linear equation, \( y = mx + b \).
   - *None* so no trend line is inserted. None is the default setting.
   - *Min* to draw a line to the dot that has the lowest y-value.
   - *Max* to draw a line to the dot that has the highest y-value.
   - *Ave* to draw a line to the average of the y-values (regardless of whether there is a dot at that value or not).
   - *All* to connect all of the dots.
3. Adjust the slider bar in the smoothing section to adjust the graph quality.
4. Click *Apply*, and then click *OK*. 
**Reference: Scatter Tab**

The following image shows the Scatter tab in the Visual Discovery Properties dialog box.

![Scatter Tab Image]

**Show Unselected**

Shows unselected data in gray. If the Show Unselected check box is not selected, unselected data is omitted from the display.

To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click Select All.

**Highlighted Point Size**

Adjusts the size of the selected nodes, thereby enabling them to stand out from the unselected nodes.

**Trend Line**

- **None**
  
  Turns off the trend line option.

- **Linear**
  
  Creates a trend line using the linear equation, \( y=mx+b \).

- **Local**
  
  Creates a trend line that curves to fit the data points.

For complete details, see *Inserting a Trend Line in a Scatter Plot* on page 176.
**Detail Data Points**

**Min**
- Draws a trend line through the minimum values in the data set.

**Max**
- Draws a trend line through the maximum values in the data set.

**Avg**
- Draws a trend line through the average of the points.

**All**
- Draws a trend line through every item in the data set.

**Glyph Size**
- Specifies the name of the data field that controls the size of points. It is best to size by a numeric field.

**Glyph Style**
- Specifies the name of the data field that controls the shape that is drawn for a point. It is best to style by a categorical field (string or integer). A fixed set of shapes are automatically assigned to data. These include a filled or open circle, filled or open square, filled or open diamond, and filled or open triangle.

**Jitter (Immediate effect)**

When points in your data set have exactly the same coordinates, overplotting can cause them to appear as a single plotted point, thus obscuring the display. You can jitter points to put more space between them.

**X**
- Jitters the x-axis points.

**Y**
- Jitters the y-axis points.

**Both**
- Jitters both the x-axis and y-axis points.

**None**
- Turns off the jitter option.
**Point size**

Adjusts the size of glyphs. To make the glyphs larger, move the slider to the right. To make the glyphs smaller, move the slider to the left.

**Transform Axis**

**Linear**

Plots all data on the axis with their exact values. You can choose to have exact values plotted for data on the x-axis, y-axis, or both axes.

This is the default data presentation.

**Root**

Displays data along the axis as the square root of its current value. For example, if the current value of a piece of data is 9 and you select Root, the data displays at 3. This is useful when looking at highly skewed distributions, because it evenly reduces the positions of the items, making them appear closer together.

You can choose the Root option for data plotted on the x-axis, y-axis, or both axes.

**Log**

Displays data along the axis as the logarithm of its current value. For example, if the current value of a piece of data is 100 and you select Log, the data displays at 2 (the log of 100 to the base 10 is 2). When you have a large range of an item (like one item in a million), Log is useful because it maintains the relative position of the item while reducing the extremes.

You can use the Log option for data plotted on the x-axis, y-axis, or both axes.

**Zooming**

Links the x-axis and y-axis when zooming.

**Reference: Scatter Plot Pop-up Menu**

The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

**Show unselected**

Shows unselected data in gray. If the Show Unselected check box is not selected, unselected data is omitted from the display.

To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click Select All.
Highlighted size

Adjusts the size of selected nodes.

Trend

Adds a trend line. For more information, see *Inserting a Trend Line in a Scatter Plot* on page 176.

Linear

Changes the scale to linear. This is the default.

Root

Displays data along the axis as the square root of its current value. For example, if the current value of a piece of data is 9 and you select Root, the data displays at 3. This is useful when looking at highly skewed distributions, because it evenly reduces the positions of the items, making them appear closer together. You can choose the Root option for data plotted on the x-axis, y-axis, or both axes.

Log

Displays data along the axis as the logarithm of its current value. For example, if the current value of a piece of data is 100 and you select Log, the data displays at 2 (the log of 100 to the base 10 is 2). When you have a large range of an item (like one item in a million), Log is useful because it maintains the relative position of the item while reducing the extremes.

You can use the Log option for data plotted on the x-axis, y-axis, or both axes.

Jitter

When points in your data set have exactly the same coordinates, overplotting can cause them to appear as a single plotted point, thus obscuring the display. You can jitter points to put more space between them.

Unjitter

Turns the jitter option off.

Larger/Smaller Points

Increases or decreases the size of the selected glyphs.

Undo

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.
Redo

Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

Select All

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

Unselect All

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

Toggle All

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

Exclude Unselected

Excludes (temporarily removes) items from the graph.

Restore Excluded

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

Save Image

Saves the graph to a GIF or JPEG file.

Copy Image

Copies the selected component and pastes it to another file.

Properties

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.
Summary Sheets

A summary sheet displays rolled up or aggregated data from several dimensions in a table. The table is rolled up according to the unique categories in the first (X-selected) column, and the measures in the other (Y-selected) columns may be summed, averaged, or counted. The display provides a zoom bar which controls scrolling through the rows of the table. The widths of the individual columns may be adjusted using the mouse. Table rows may be selected and deselected. Selections in other visual controls may result in partial selection in categories. Only the selected rows are represented in the summary sheet. By default, completely unselected categories do not appear at all. Summary sheets also enable you to sort the table by any column and fit the table into the allotted space.

Reference: Summary Sheet Tab

The following image shows the Summary Sheet tab in the Visual Discovery Properties dialog box.

Line Representation

**Full Size**

Shows text in a normal, readable size.

**Pixel/line**

Draws text as one-pixel-high lines. This is helpful when you need to reduce the size of the text to see more of the data. Depending on how many lines you have in your table, this may still require paging to see all rows.
**Fit All**

Shows the entire table in the current window. If there are fewer table rows than will fit in the window at full size, then the lines are shown in a larger font with more spacing. If there are more lines than will fit (the more common case), then they are reduced to a smaller size, with a minimum height of 1 pixel. If all table rows does not fit at 1 pixel high, then lines are overplotted to allow all to fit. When values are overplotted, the line that is the longest or with the hottest color is drawn on the top, obscuring all others under it.

**Show Unselected**

Shows unselected data in gray. If the Show Unselected check box is not selected, unselected data is omitted from the display.

To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click **Select All**.

**Indent Text**

Indents text fields if the text has leading white space. When this option is not selected, the leading white space is ignored in text fields so that all fields start against the left column border.

**Scale Mode**

Shows the reduced line representation option. When this option is not selected, the display is locked into text mode.

**Tool Tips**

Displays the entire string of a truncated line when the cursor is placed in the column.

**Display Focus Line**

Displays the name of each selected (in focus) field.

**Sort By**

Sorts the glyphs by the specified field.

**Reverse Sort By**

Reverses the sort order.

**Remove**

Removes the highlighted field from the sort.
Time Tables

Time tables show activities or tasks over a period of time. Tick marks representing individual data records are displayed across a grid in a pattern directly related to the time of their occurrence. Time tables are used to show large numbers of events over time and for studying the interrelationships between those events.

The time table control of WebFOCUS Visual Discovery enables you to monitor the timing and pattern of vital business activities. You can use shaped or angled glyphs or symbols to represent specific activities, group related ticks together on the grid, adjust the size and color of ticks to indicate event duration, and view the value of another variable.

The following image shows an example of a time table.

![Time Table Example](image_url)

The time table provides information in two areas of the graph: the bar chart area and the main window area. The bar chart area graphs the number of tick marks that occur in a row. In the default presentation, each tick mark in the main window area represents one record in the bar chart area.

The main area of the time table presents most of the information. The label for the vertical y-axis is displayed across the top of the graph. (In the following graphic, the label is Agent_Name.) The y-axis values appear along the vertical axis and time is plotted along the x-axis. The data is displayed using tick marks or other glyphs, depending on the field values you apply.

When a tick mark is not in focus, the bar chart provides a relative view of the tick marks and the number of times a tick mark occurs. When the tick mark is in focus, the:

- Tick mark is colored green (green is the default selected color).
Procedure: How to Select Glyph Shapes for a Time Table

1. Select the desired data source in the Properties and settings dialog box.
2. Click ActiveX Properties. The Visual Discovery Properties dialog box will open.
3. Click the Time Table tab. From the Visuals Controlled by Table field, select:
   - Group to organize the data into sets by field. Select a field from the drop-down list.
   - Size to specify the size of the glyph based on the field. Select a field from the drop-down list.
   - Glyph/Angle to display glyphs using shapes (instead of tick marks), according to an applied field value. Select a field from the drop-down list. Select the Use Angles for Glyphs check box to angle the tick marks another field uses.
   - Duration to display glyphs as a line (tail), that represents duration. Select a field from the drop-down list. Select the Filled Durations check box to show the data as filled bars.
4. Click Apply.
Reference: Time Table Tab

The following image shows the Time Table tab in the Visual Discovery Properties dialog box.

![Time Table Tab Image]

**Visuals Controlled by Table Field**

**Group**

Organizes the data into data sets by the selected field.

**Size**

Sizes the glyphs based on the selected field.

**Glyph/Angle**

Displays glyphs using different shapes (instead of the default tick marks) according to the value of the selected field.

**Duration**

Shows durations according to the selected field. The glyphs will appear as a line (tail).

**Show Unselected**

Shows unselected data in gray. If the Show Unselected check box is not selected, unselected data is omitted from the display.

To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click Select All.

**Use Angles for Glyphs**

Displays glyphs as angled tick marks instead of shapes. This change is applied to the field selected in the Glyph/Angle section of the Visuals Controlled by Table Field area.
**Filled Durations**
Changes the default presentation from lines with tails to filled bars. This size change is applied to the field selected in the Duration section of the Visuals Controlled by Table Field area.

**Glyph Size (Immediate effect)**

- **Default**
  Changes the relative sizes of the glyphs back to their original size.

- **Larger**
  Increases the relative size of the glyphs.

- **Smaller**
  Decreases the relative size of the glyphs.

**Reference: Time Table Pop-up Menu**
The pop-up menu appears when you right-click a Visual Discovery control in the analytical dashboard. These options do not appear when you are developing in HTML Composer.

- **Show unselected**
  Shows unselected data in gray. If the Show Unselected check box is not selected, unselected data is omitted from the display.

  To add unselected data, either select the Show Unselected check box in the Properties dialog box, or use the right mouse button menu in the view and click Select All.

- **Use angles for glyphs**
  Displays the glyphs as angled tick marks instead of shapes.

- **Filled durations**
  Changes the default presentation from lines with tails to filled bars.

- **Hide/Show ‘name’**
  Hides or shows the name of the selected label.

- **Sort ‘name’ categories**
  Orders the items in the selected group by category (y-axis labels).

- **Sort ‘name’ counts**
  Orders the items in the selected group by count (highest to lowest values).
6. Visualization Components: Descriptions and Usage

**Full Size**

Shows text in a normal, readable size.

**Fit All**

Shows the entire table in the current window. If there are fewer table rows than will fit in the window at full size, then the lines are shown in a larger font with more spacing. If there are more lines than will fit, then they are reduced to a smaller size, with a minimum of 1 pixel high. If all table rows does not fit at 1 pixel high, then lines are overplotted to allow all to fit. When values are overplotted, the line that is the longest or with the hottest color is drawn on the top, obscuring all others under it.

**One Line/ Pixel**

Draws text as one-pixel-high lines. This is helpful when you need to reduce the size of the text to see more of the data. Depending on how many lines you have in your table, this may still require paging to see all rows.

**Undo**

Reverses the previous action. You may repeatedly undo actions retained in the history file for your current session by selecting Undo over and over again. A description of the previous action appears on the pop-up menu. If you have performed no action, Undo is not available for selection and no action appears to the right of the word Undo.

**Redo**

Restores the previous undo action. If you have performed no action, Redo is not available for selection and no action appears to the right of the word Redo.

**Select All**

Selects all of the items in the graph. When you choose Select All, any previous selections are ignored. Selection state returns to the original setting.

**Unselect All**

When selected, all of the items become unselected. All items appear in the unselected color (gray, by default) or are hidden in the graph (if hide unselected is active).

**Toggle All**

Reverses the selection state of items. Selected items become unselected and unselected items become selected.

**Exclude Unselected**

Excludes (temporarily removes) items from the graph.
**Restore Excluded**

Restores the items you excluded. If you accidentally excluded the unselected, this menu option restores those excluded items.

**Save Image**

Saves the graph to a GIF or JPEG file.

**Copy Image**

Copies the selected component and pastes it to another file.

**Properties**

Takes you to the collection of tabs available for the respective visualization component. Common tabs include Data, Selecting, and Colors.
**Reference: Time Table Glyphs**

The default glyph used in the time table is the tick mark. Depending on your intended purpose, other sizes, angles, and shapes of glyphs may be helpful. The following table shows different styles of tick marks and what type of data they represent.

<table>
<thead>
<tr>
<th>Glyph</th>
<th>Name</th>
<th>Use</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Tick Mark" /></td>
<td>Tick Mark</td>
<td>The default presentation where each tick mark stands for one record.</td>
<td>Each tick mark stands for one time that a call center agent is online. Tick marks can also be sized by a field value. The height of the tick mark represents another field.</td>
</tr>
<tr>
<td><img src="image" alt="Angles for Glyphs" /></td>
<td>Angles for Glyphs</td>
<td>Tick marks are angled to represent another field. May be useful when you want to see multiple data fields at the same time.</td>
<td>Tick marks represent a class of skills. Each angled tick mark represents a subcategory of skill. If an agent has more than one subcategory skill, the lines cross. If an agent, for example, had the entire subcategory of skills, the glyph would look like a star so it would be easy to see who your most skillful agents are.</td>
</tr>
<tr>
<td><img src="image" alt="Glyph/Angle" /></td>
<td>Glyph/Angle</td>
<td>Glyphs of different shapes (circle, X, line, square) are used to represent subcategories of a record. The first six unique values are assigned a shape. The remaining values are assigned a dot.</td>
<td>Each shape represents a subclass of skills. If an agent has more than one subcategory of skills, only the last applied subclass is represented by a glyph. If you want to see how many agents have experience in a specific subclass, all those having the same shape may be more easily identified than those with the same angular line.</td>
</tr>
</tbody>
</table>
### Duration

<table>
<thead>
<tr>
<th>Glyph</th>
<th>Name</th>
<th>Use</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Default Duration" /></td>
<td>Default Duration</td>
<td>Line length is used to show the duration (span over time). The line is shown with a tail (tick mark) at the beginning. If rows of data overlap, this may be used to see the overlap more clearly than filled bars. Duration fields must be numeric.</td>
<td>Duration lines are used to show the length of time an agent is online. The longer the agent is online, the longer the line. If there are many agents (Y values), the default duration presentation allows more agents to be shown in a smaller area.</td>
</tr>
<tr>
<td><img src="image" alt="Filled Duration" /></td>
<td>Filled Duration</td>
<td>Changes the duration line to a bar. Bar length is used to show the duration (span over time). Duration fields must be numeric.</td>
<td>Duration lines are used to show the length of time the agent is online. The longer the agent is online, the longer the bar.</td>
</tr>
</tbody>
</table>
Perspectives

You can link a combination of visualization components and place them together on a single page or screen to obtain a simultaneous view of multiple facets of critical information. Perspectives can be created ad hoc, to answer immediate business questions or reused for other reporting and monitoring tasks. The following image shows an example of multiple components linked together on the same screen.

The following topics will help you create your own perspectives on key business data: Selecting Data on page 28 and Assigning Color to the Data and the Graph on page 31.
Using the Visual Discovery JavaScript API

This appendix illustrates examples of how to use basic JavaScript coding with Visual Discovery chart controls.

**In this appendix:**
- About JavaScript API
- Customizing Visual Discovery Applications With JavaScript
- Using the VzScript Library

**About JavaScript API**

Visual Discovery provides a JavaScript API that allows developers to add customized functionality to their applications so that analysts can manipulate the graphical components effectively at run time. JavaScript code is reserved for functions, event handling, and page interaction once the HTML page is loaded at run time.

The examples in this appendix assume you know basic JavaScript concepts and syntax. The JavaScript Tags referenced below, summarize the constructs you use with Visual Discovery controls.

Detailed information on the Visual Discovery JavaScript API properties and methods is available in the Visual Discovery Online Help. In addition, several instances of using JavaScript code to enhance a Visual Discovery application are used in *Tutorial: Building a Visual Discovery Analytic Dashboard with Advanced Chart Controls* on page 65. The tutorial will familiarize you with the JavaScript API, to enhance your Visual Discovery applications.

**Reference: JavaScript Tags**

As you go through this appendix, refer to the following table, which summarizes basic constructs.

<table>
<thead>
<tr>
<th>Construct</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>//</td>
<td>Comment line. Used at the end of a line of code or on a line by itself.</td>
</tr>
</tbody>
</table>
Customizing Visual Discovery Applications With JavaScript

When running a Visual Discovery application, several functions are automatically available through the context menu. Chart properties are also available by selecting Properties from the context menu and then navigating through the Properties tab of the control. You can also use JavaScript to code functions and properties inside your application, activating them based on the click of a button or a change in a combo box selection. Options set for one Visual Discovery control are applied to all charts on the page.

The following table provides a few of the most commonly used Visual Discovery JavaScript functions. A complete list of commands is available in the Visual Discovery Online Help file.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7111 HIDEUNSELECTED</td>
<td>Exclude (delete) unselected rows. All selection state changes affect all views.</td>
</tr>
<tr>
<td>7112 SHOW ALL</td>
<td>Restore excluded (deleted) rows.</td>
</tr>
<tr>
<td>7115 SELECT</td>
<td>Select all rows.</td>
</tr>
<tr>
<td>7116 UNSELECT</td>
<td>Unselect all rows.</td>
</tr>
<tr>
<td>7117 TOGGLE</td>
<td>Toggle (reverse) selection state on all rows.</td>
</tr>
<tr>
<td>7118 UNDO</td>
<td>Undo last operation.</td>
</tr>
<tr>
<td>7119 REDO</td>
<td>Redo last operation.</td>
</tr>
</tbody>
</table>
**Note:** The Exclude and Restore Excluded, also known as Show All, are provided as options in the hyperlink properties of an HTML Composer control.

---

**Example:** Adding Undo and Redo Button Controls

You can add the JavaScript code for Undo and Redo controls at design time. After adding an HTML Composer control, such as a button or combo box to the Visual Discovery page, click *Events* from the Properties pane, and double-click the ellipsis button for the event you wish to use. The examples below use the onclick event. This brings you to the event function code in the Embedded JavaScript tab of the HTML Composer window.

You can add JavaScript code to functions and properties inside your application at design time, after adding an HTML Composer control, such as a push button or combo box. You must first add a Visual Discovery component. The examples below use a button control and refer to a Visual Discovery bar chart. These functions can also be applied to combo boxes.

To add an undo control:

1. Open an HTML page containing a Visual Discovery component, in HTML Composer.
2. From the Menu bar, click *Insert*, click *Controls*, and then click *Push Button*.
3. Edit the attributes of your button as desired.
4. With the button selected, click the *Events* tab on the Properties menu pane and click the *onclick* ellipsis button.
   - This opens the Embedded JavaScript tab in HTML Composer.
5. Add the following code between the opening and closing braces:

   ```javascript
   activex1.command(7118,"",0,0);//***Undo Last Operation
   
   where:
   
   activex1
   
   is the name of your Visual Discovery control. If you named your Visual Discovery bar chart control `VBar1`, that is the name you should use.

6. Save your work and run the page.

To add a redo control:

1. Repeat steps 1-4 from above.
   - The Embedded JavaScript tab opens and the cursor appears under the code for the second button.
2. Add the following code between the opening and closing braces:

```javascript
activex1.command(7119,"",0,0);//***Redo Last Operation
```

where:

```javascript
activex1
```

Is the name of your Visual Discovery control. This should be the same name you used for the undo control.

3. Save your work and run the page.

The complete JavaScript coding for the undo and redo controls should look similar to the following image.

```javascript
//Begin function window_onload
function window_onload() {
  UpdateData();
  // TODO: Add your event handler code here
  // add onInitialUpdate() function to make changes before initial run of the reports
  // End function window_onload

  //Begin function vzUndo_onclick
  function vzUndoBtn_onclick(ctrl) {
    VBari.command(7118,"",0,0);//***Undo Last Operation
  }
  //End function vzUndo_onclick

  //Begin function vzRedoBtn_onclick
  function vzRedoBtn_onclick(ctrl) {
    VBari.command(7119,"",0,0);//***Redo Last Operation
  }
  //End function vzRedoBtn_onclick
}
```

**Note:** The buttons are identified in the code as vzUndo, and vzRedo. This will be different if you identify the buttons by different Unique Identifiers. The same is true for the Visual Discovery control.

**Example:** Setting Color Properties

You can also use JavaScript coding to set properties of Visual Discovery charts at run time. The following example sets two of the color properties in an event handler for a button.

This example uses the same procedure outlined in the Undo and Redo Button controls. The code shown below sets the background color to yellow and the selected color to sky blue, using the six-digit hexadecimal codes for RGB color values.

To add color controls:
1. Open an HTML page containing a Visual Discovery control, in HTML Composer.

2. From the Menu bar click Insert, click Controls, and then click Push Button.

3. Edit the attributes of your button as desired.

4. With the button selected, click the Events tab on the Properties menu pane and click the onclick ellipsis button.

   This opens the Embedded JavaScript tab in HTML Composer.

5. Add the following code between the opening and closing braces:

   ```javascript
  activex1.BackgroundColor='0xFFFF00'; //Yellow
  activex1.PressedColor='0x3299CC'; //Sky Blue
   ```

   where:

   ```javascript
   activex1
   ```

   Is the name of your Visual Discovery control. If you named your Visual Discovery bar chart control VBar1, that is the name you should use.

6. Save your work and run the page.

For more information on setting colors through the Visual Discovery Online Help, and accessing additional Help topics, see Accessing Visual Discovery Online Help on page 61.

## Using the VzScript Library

If you are an advanced JavaScript programmer, you can use the VZScript library included with Visual Discovery to further customize your Visual Discovery pages. In addition, you can also include your own JavaScript files coded outside of WebFOCUS.

The VZScript library is located in the following directory:

```markdown
drive:/path/ibi/DevStudio81/ibi_html/visdis/VzScripts
```

From the Insert menu in HTML Composer, click Insert CSS/Script. The Insert Web Files dialog box opens, where you can browse through the available JavaScript (.js) files. Select the files that you want to reference in your Visual Discovery page. A copy of each JavaScript file will be saved to your local directory.

**Note:** When you run a deployed version of your Visual Discovery application from the WebFOCUS environment, verify the following:

- All JavaScript files referenced in the .htm file are available in the run-time environment.
- The full path, in the .htm file, reflects the correct file location.
If you use the *Deploy Scenario Wizard* from the Projects area, these steps are automatically completed when you assign the .js files to the web server deployment path.

For more information on using JavaScript files in HTML Composer, see the *Designing a User Interface for a Web Application With HTML Composer* manual.
### Glossary

<table>
<thead>
<tr>
<th><strong>ActiveX control</strong></th>
<th>A graphical component that uses ActiveX technology. ActiveX is a software component of Microsoft Windows, and enables features such as animation. A WebFOCUS Visual Discovery control is an ActiveX control.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>animation</strong></td>
<td>Occurs when each glyph is sequentially highlighted and then restored to its original state. Animation is useful when you are analyzing two or more interactive data visualization controls at the same time because you can easily see the highlighted items in all displayed controls simultaneously.</td>
</tr>
<tr>
<td><strong>bar chart</strong></td>
<td>A diagram that provides a means of quantitative comparison by displaying rectangular bars of differing heights or lengths that are proportional to the statistics or data they represent. Bar charts display the distribution of a single, discrete or dependent variable across an independent variable.</td>
</tr>
<tr>
<td><strong>bookmark</strong></td>
<td>A combination of display characteristics, such as the selection state (data that is selected, unselected, or excluded) and the colors used in the control. The bookmark feature allows you to save a specific state in your analysis, so you can return to it at a later time without recreating it from the beginning.</td>
</tr>
<tr>
<td><strong>count</strong></td>
<td>Provides a statistical summary of a data table, and lists exact numerical values for data fields within the table, in an easy-to-read, textual format.</td>
</tr>
<tr>
<td><strong>data constellation</strong></td>
<td>Also known as a constellation graph. Depicts multiple data sets or groups of data sets with particular attributes and maps the association between them. They are called constellations because they are made up of numerous stars or nodes. Each star represents a specific data value that is distanced from and connected to other stars on the diagram plane in proportion to the strength or weakness of their relationship.</td>
</tr>
<tr>
<td><strong>data sheet</strong></td>
<td>Creates a table style view of a set of fields so you can uncover interactions and patterns.</td>
</tr>
<tr>
<td><strong>data visualization</strong></td>
<td>Transforms raw data into perceptive images, providing a powerful and dynamic instrument for the discovery and reasoning of quantitative information.</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>design time</strong></td>
<td>The period in which you are creating or editing your page using the Developer Studio tools.</td>
</tr>
<tr>
<td><strong>glyph</strong></td>
<td>A graphic, such as an icon, used to represent data.</td>
</tr>
<tr>
<td><strong>goal line</strong></td>
<td>Lines you can place on a bar or a line chart in the report output. Goal lines display in front of the graphed data, enabling you to compare your data with one or more set values.</td>
</tr>
<tr>
<td><strong>histogram</strong></td>
<td>A chart that groups data values into classes and shows the frequency at which each class appears in the data set by displaying a series of columns whose width represents class intervals and whose areas are proportional to the corresponding frequencies.</td>
</tr>
<tr>
<td><strong>line chart</strong></td>
<td>A chart that compares the relationship between two variables, one dependent, and one independent. It demonstrates the effect of the independent variable on the dependent variable by showing successive points, each representing a different data value, connected by straight lines.</td>
</tr>
<tr>
<td><strong>Mercator Projection</strong></td>
<td>When creating a map in image format, there will be some distortion because the Earth is round, yet you are creating a 2D image. Mercator Projection allows you to make accurate maps, despite the distortion.</td>
</tr>
<tr>
<td><strong>multiscape</strong></td>
<td>Provides a visual representation of the interaction or relationship between two or more associated data fields by plotting one variable on the X axis and one or more variables on the Y axis.</td>
</tr>
<tr>
<td><strong>paradox</strong></td>
<td>A hybrid of box plots and parallel coordinate plots, made up of multiple columns. The first column contains specific values from a data group (each displayed as a bubble, sized to demonstrate the number of records it represents), with the remaining columns each representing a specific characteristic of that group.</td>
</tr>
<tr>
<td><strong>run time</strong></td>
<td>The period after you have created and deployed your page, when your page displays in the Developer Studio Viewer or Internet Explorer. You cannot edit the page at run time, but you can modify attributes of the Visual Discovery charts.</td>
</tr>
<tr>
<td><strong>scatterplot</strong></td>
<td>Also called a scatter gram or scatter diagram, it is used to investigate the possible association between two variables that both relate to the same event, by distributing a series of points or nodes, each representing a value in the data set, across a grid.</td>
</tr>
<tr>
<td><strong>smoothing</strong></td>
<td>A statistical technique in which data is averaged to remove extreme highs and lows.</td>
</tr>
<tr>
<td><strong>summary sheet</strong></td>
<td>Displays rolled up, or aggregated data from several dimensions in a table.</td>
</tr>
<tr>
<td><strong>thick-client deployment</strong></td>
<td>Visual Discovery components run on the workstation of the end user as binary ActiveX controls within an Internet Explorer page. The ActiveX controls are installed on a workstation the first time an end user accesses a webpage that uses them. Webpages that use the visual components contain parameters and scripts to configure them and load data into them from network sources.</td>
</tr>
<tr>
<td><strong>tick mark</strong></td>
<td>The default glyph used in time table charts where each tick mark stands for one record.</td>
</tr>
</tbody>
</table>
**time table**

Shows activities or tasks over a period of time. Tick marks, representing individual data records, are displayed across a grid in a pattern directly related to the time of their occurrence. Time tables are used to show large numbers of events over time and for studying the interrelationships between those events.

**WebFOCUS Visual Discovery**

Provides advanced graphical techniques for creating visual perspectives of multi-dimensional business data, and provides robust chart interactivity so you can visually analyze and detect trends and anomalies across multiple dimensions and categories.

**WebFOCUS Visual Discovery controls**

Graphical components that use ActiveX technology. WebFOCUS Visual Discovery controls are available through Developer Studio and are developed using the HTML Composer tool.
Index

.fex file 66

3D multiscapes 159, 166
3D surfaces in multiscapes 161
3D tab 167

A

ActiveX Properties 29
  button 29
Add Data Pool 29
adding a data source 28
adding data 28
adding data pools 28
adding JavaScript chart control 195
advanced chart controls 65
aggregating data in Visual Discovery 128
analytic dashboards 23, 65
angles for glyphs 191
animating data 45
applications, deploying 107
Available Data Pools 29

B

background color 31
Bar Chart pop-up menu 119
Bar Chart tab 118
bar charts 45, 46, 114, 115, 116, 117
  animating data 45, 46
  orientation 115
  primary order 46
  secondary order 46
  spine plots 116
bar charts (continued)
  using clusters 117
basic Java examples 196
blocks in multiscape 161
boxplots 169, 171
bubble options for paraboxes 172
bubbles 161, 171
  in multiscape 161

C

categorical color scale 36
chaining into a Visual Discovery control 54
circle brush selector 41
circle selector 41
circular charts 127
clusters
  in bar charts 117
  color 31, 32, 36
    graph elements 32
      using a field 36
Color By 37
color scale 33
coloring multiscapes 162
Colors tab 33
column charts 114
component element colors 33
components
  types of 113
constellation
  graphs 141
  maps 143
control names 28
counts 137
Counts pop-up menu 139
Counts tab 139
creating a data constellation with a map 76
creating a data file 23
creating an HTML file 67
customizing colors 32

dashboards 26
data 28, 186
  in time tables 186
data constellation maps 143
data constellations 141, 142
Data Constellations pop-up menu 152
Data Constellations tab 148
data files 23, 66
data pool 28
Data Sheet pop-up menu 157
Data Sheet tab 156
data sheets 154, 155
Data tab 30
  icons 30
deploying Visual Discovery applications 107
  using VZ Web (thick client) 107
developing a dashboard 23, 26, 65
dot strips 171
duration 191

equalized color scale 36
excluding data 57
executive dashboards 15
exploding data in a pie chart 128

fields
  coloring data by 36
Fill Between Areas 123
filled duration 191
fit all option 156
flicker-free drawing 41
format conversions for format VISDIS 23
FORMAT VISDIS 23

glyph/angle 191
glyphs 114, 186, 191
  in time table 186, 191
goal lines 44, 45
  adding 44
  hiding 45
  moving 45
  removing 45
  selecting values 45
graph element colors 32
graphs
  Visual Discovery 113
gray color scale 36
green/red color scale 36

Histogram pop-up menu 135
Histogram tab 135
histograms 133, 134
  orientation 133
  selecting scale 134
  smoothing 134
horizontal bar charts 114
HTML Composer 27
HTML Composer Visual Discovery integration 37
icons in Data tab 30
icons in paraboxes 171
installing 19, 20
  Visual Discovery components 19
  Visual Discovery VZ Web (thick client) 20
JavaScript API 195
JavaScript Coding
  basic coding 195
JavaScript constructs 195
JavaScript tags 195
label color 31
labels 47, 48
  hiding 48
    in bar, line, and pie charts 47
  showing 48
lasso selector 41
Line Chart pop-up menu 124
Line Chart tab 123
line charts 45, 46, 122, 123
  animating data 45, 46
  orientation 123
    primary order 46
    secondary order 46
linear scale 134
linking visualization components 193
log scale 134
Managed Reporting thick-client deployment 108
Multiscape pop-up menu 164
Multiscape tab 163
multiscapes 159, 161, 162, 166
  3D 166
    coloring 162
    display methods 161
    reordering 161
N-way multiscape 159
naming conventions 28
net aggregation 128
Net Mode 129
one line/pixel option 156
one step 148
order 46
  primary 46
  secondary 46
orientation
  bar charts 115
  histograms 133
line charts 123
output formats 23
overlay text color 31
Parabox pop-up menu 174
Parabox tab 172
paraboxes 168, 169, 171, 172
  bubble options 172
  ordering data 171
  presentation options 171
parameterized procedure 49
passing between a Visual Discovery control and a report 49
pastel color scale 36
PCHOLD FORMAT VISDIS 66
perspectives 193
Pie Chart pop-up menu 131
Pie Chart tab 130
pie charts 45, 46, 127, 128
  animating data 45, 46
  exploding data 128
  primary order 46
  rotating data 128
  secondary order 46
preselecting values 48
primary order 46
Properties and settings 29

R
rainbow color scale 36
re-apply color to field 36
rectangle selector 41
rectangular brush selector 41
Remove Data Pool 29
reordering multiscapes 161
restoring data 57
root scale 134
rotating data in a pie chart 128

S
sample chart interface 65
scale mode 156
scales
  in histograms 134
  linear 134
  log 134
  root 134
scatter diagrams 175
scatter plot 175, 176
  uses 176
secondary order 46
selecting data 28
selecting glyph shapes for time table 186
Selecting tab 41
selection options 40
showing positive/negative data 128
side blocks in multiscape 161
simple statistics 139
smallest values are high priority option 36
smoothing 134
spine plots 116, 161
  in multiscape 161
standard tool element colors 33
statistical summary data tables 137
step in 148
step out 148
summary sheet 183

T
thermal color scale 36
thick-client deployment
  Managed Reporting 108
  WebFOCUS Client 109
tick marks 191

time table glyphs 191

Time Table pop-up menu 188

Time Table tab 185

time tables 185

trend lines 176, 177

tutorial 65

two-way multiscape 159

U

using color 31

V

vertical bar charts 114

Vis button 27

VisDis Color By 37

VISDIS format 23

Visual Discovery 15, 23, 27, 57

   button 27

   Exclude 57

   format 23

   restore 57

Visual Discovery controls 27, 54

   chaining 54

visualization types 113

VZ Web Server 20

Vz.cab file 107

VzLicense.lpk file 107

VzScript library 199

W

web features 59

WebFOCUS Client thick-client deployment 109

WebFOCUS Visual Discovery 15

Weighting Mode 129

weighting multiscape 161

working on the web 59
Customer Connections

Where users partner with Information Builders to provide feedback and create quality documentation.

Partner With Us

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also join a usability study to get an early look at new documentation products and services. Your participation helps us create documentation products that meet your needs.

To send us feedback or make a customer connection, contact Michele Brady, Service Director, Technical Content Management at Michele_Brady@ibi.com.

Request Permission to Use Copyright Material

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.

Visit the Information Builders Technical Content Library

To visit the Technical Content Library, go to http://documentation.informationbuilders.com/.